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This preface contains the following topics:

• “Who should read this guide” on page vi

• “What this guide covers” on page vii

• “Accessing Automation Solutions user guides” on page viii
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Who should read this guide

Job roles

This user guide is for people with the following job roles:

 

Related topics

Job role Responsibilities

Integrator Someone who writes software and configures hardware 
controlled by VWorks software.

Lab manager, 
administrator, or 
technician

Someone who is responsible for:

• Developing the applications that are run using 
VWorks software

• Developing training materials and standard 
operating procedures for operators

Operator Someone who performs the daily production work 
using VWorks software and solves routine problems.

Your organization may choose to create its own 
procedures for operators including the procedures in 
this guide.

For information about... See...

What is covered in this guide “What this guide covers” on 
page vii

How to access user guides “Accessing Automation Solutions 
user guides” on page viii

VWorks software available 
licenses

“Description of VWorks software 
license packages” on page 2
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What this guide covers 

What is covered

This guide describes how to:

• Install VWorks software

• Migrate protocols from previous versions of VWorks software.

• Define labware

• Specify pipette speed and accuracy

• Track and manage labware using a database inventory system,

• Manage user accounts

• Implement ActiveX

What is not covered

This guide does not provide instructions for the following:

• Writing protocols

• Running protocols

• Troubleshooting protocols

• Operate devices using VWorks software

For information about these topics, see the VWorks Automation Control User 
Guide, relevant Agilent Technologies device user guide or third- party user 
documentation.

Software installer

This guide documents VWorks software installer 9 and later.

Related guides

The VWorks Automation Control Setup Guide should be used in conjunction 
with:

• VWorks Automation Control User Guide

• Agilent Technologies device user guides

• Third- party device user documents

Related topics

For information about... See...

Accessing user guides for 
Automation Solutions products

“Accessing Automation Solutions 
user guides” on page viii

VWorks software available 
licenses

“Description of VWorks software 
license packages” on page 2
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Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com.

Accessing safety information

Safety information for the Automation Solutions devices appears in the 
corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Related topics

For information about... See...

What this guide covers “What this guide covers” on 
page vii

Who this guide is for “Who should read this guide” on 
page vi

VWorks software available 
licenses

“Description of VWorks software 
license packages” on page 2
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1
Installing and setting up the 
VWorks software 

This chapter contains the following topics:

• “Description of VWorks software license packages” on page 2

• “Installing the VWorks software” on page 3

• “Uninstalling the VWorks software” on page 4

• “Upgrading or replacing the VWorks software license” on page 6

• “Migrating files created in VWorks 3 and BenchWorks” on 
page 7
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Description of VWorks software license packages

License packages

There are eight license packages available for VWorks Automation Control 
software. They are described in the table below.

Related topics

This package... Is used for...

Simulation license Running VWorks software in simulation 
mode. This license is useful for testing 
protocols on computers that are not 
controlling any devices.

Instrument license Controlling a Bravo Platform, Vertical 
Pipetting Station, or Microplate Labeler 
in a standalone mode. 

BenchTop license Either 

• Controlling a BenchCel Workstation 
and up to 10 devices associated with 
it.

• Controlling a BenchCel Workstation 
using 3rd- party software.

System license Controlling an automation system that 
has an articulating robot arm such as a 
3- Axis Robot.

VWorks Appication Programming 
Interface license

Controlling VWorks software by an 
external system.

VWorks Hooks Interface license Integrating with LIMS, sample, and 
workflow management systems by 
providing a callback interface to hook 
into key VWorks software events.

VWorks DCL Interface license Writing device drivers using a COM 
interface.

VWorks Software Developer Kit 
license

Interfacing with VWorks software using 
VWorks Appication Programming 
Interface license, VWorks Hooks Interface 
license, and VWorks DCL Interface 
license.

For information about... See...

Installing VWorks software “Installing the VWorks software” on 
page 3
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Installing the VWorks software

About this topic

This topic explains how to install the VWorks software. If you have an existing 
version of VWorks software on the computer, and you are upgrading, see 
“Upgrading or replacing the VWorks software license” on page 6. If you have a 
previous version of VWorks, you must uninstall it first. For instructions, see 
“Uninstalling the VWorks software” on page 4.

Procedure

To install the new VWorks software

1 Insert the VWorks software CD into the computer's CD- ROM drive. The 
software installer should start automatically. If it does not, navigate to the 
CD- ROM drive, and then double- click VWorks.exe.

2 Follow the instructions on the installation software screens.

3 In the last screen, select Launch VWorks software Activation Program if this is a 
new VWorks software installation (you did not have an existing version on 
the computer).

4 Click Finish. If you selected Launch VWorks software Activation Program, 
the VWorks software Activation dialog box opens. Follow the instructions 
in the dialog box to obtain a software license file.

5 Place the license file (VWorks.vln) in the folder that contains the VWorks 
software. For example, if you installed the software in the C:\Program 
Files\Agilent Technologies\VWorks folder, place the VWorks.vln file in that 
folder.

Related topics

Uninstalling VWorks software “Uninstalling the VWorks software” on 
page 4

Upgrading to a new licence “Upgrading or replacing the VWorks 
software license” on page 6

Migrating a protocol created with 
a previous version of VWorks 
software

“Migrating files created in VWorks 3 
and BenchWorks” on page 7

For information about... See...

For information about... See...

Upgrading software license “Upgrading or replacing the VWorks 
software license” on page 6



1   Installing and setting up the VWorks software
Uninstalling the VWorks software

4 VWorks Automation Control Setup Guide

Uninstalling the VWorks software

About this topic

If you have a previous version of the VWorks software, you must first uninstall 
it before installing the new software. This topic explains how to uninstall the 
existing software.

When to remove the Automation Solutions registry files

Typically, uninstalling the VWorks software without removing the registry files 
is sufficient. However, you can remove the Automation Solutions files from the 
registry if:

• You want to make a completely fresh start with VWorks software, removing 
all user accounts, teachpoints, device profiles, and liquid and labware 
definitions, 

or

• You do not intend to run VWorks software on that computer again

Procedures

To remove VWorks software:

1 On the Start menu, Control Panel. The Control Panel window appears. 

2 Double- click Add/Remove Programs. The Add or Remove Programs dialog box 
opens.

3 Locate and select the VWorks software you want to uninstall, then click 
Change/Remove. The removal process might take a few minutes.

When the removal process is finished, the following folder and file remain in 
the ...\VWorks or ...\VWorks4 folder:

• Users folder

• VWorks.vln file

The following folders remain in ...\VWorks Workspace if they contain files:

• Barcode Input Files

• Protocol Files

• Device Files

• RunSet Files

Uninstalling VWorks software “Uninstalling the VWorks software” on 
page 4

Migrating protocols created with a 
previous version of VWorks 
software

“Migrating files created in VWorks 3 
and BenchWorks” on page 7

For information about... See...
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• Scripts  

• VWorks

– Pipette Techniques 

– Hit Picking

– Tip Box States 

– Logs 

To remove the VWorks software files from the registry:

1 From the Windows Start menu, select Run.

2 In the Open text box, type regedit.

3 Click OK. The Windows registry editor opens.

4 Expand folders to select the following folder:

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11 

Make sure you have selected the Velocity11 folder.

5 Select Edit > Delete. 

Related topics

CAUTION The following procedure deletes the user accounts, labware definitions, liquid 
library data, device profiles, and teachpoints.

CAUTION Making a mistake and deleting the wrong registry folder can cause critical 
failures with your operating system.

For information about... See...

Converting protocols created with 
previous versions of VWorks 
software

“Migrating files created in VWorks 3 
and BenchWorks” on page 7

Reporting a problem VWorks Automation Control User 
Guide

Setting up email for error 
notification

“Setting up email for error notification” 
on page 105
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Upgrading or replacing the VWorks software license

About upgrading

If you purchased an upgrade to VWorks software, or if you lost your current 
license, you do not have to re- install the software but you must activate the 
new license.

Procedure

To upgrade or replace your new license:

1 Open VWorks software.

2 Select Options > Request license file.

3 Follow the instructions in the dialog box to obtain a software license file.

4 For upgrading to a new license:

• Place the license file (VWorks.vln) in the folder that contains the 
VWorks software and allow it to overwrite the old license file.

For replacing a lost or deleted license:

• Place the license file (VWorks.vln) in the folder that contains the 
VWorks software.

For information about... See...

Uninstalling VWorks software “Uninstalling the VWorks software” on 
page 4

Available VWorks software licenses “Description of VWorks software license 
packages” on page 2

Migrating protocols created in a 
previous version of VWorks 
software

“Migrating files created in VWorks 3 
and BenchWorks” on page 7
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Migrating files created in VWorks 3 and BenchWorks

About this topic

When you start the VWorks software for the first time, you will be prompted 
to migrate existing BenchWorks or VWorks3 protocols and associated files so 
that they will be compatible in the new software. This topic explains how to 
migrate the protocols and associated files.

Files types that require migration

The following BenchWorks or VWorks3 files must be migrated to be compatible 
in the new software:

• Profiles

• Devices

• Protocols

• Runsets

• Labware

• Liquid classes

• JavaScript

Preparing for the migration

Careful planning and preparation can optimize the migration process. Before 
you start migrating your files, make sure you are aware of any limitations or 
post- migration adjustments you need to make. For example, some devices have 
been renamed. The software will change the device names during migration, 
but you should review the files to make sure they are correct before running 
protocols.

If you have questions or need assistance, contact Automation Solutions 
Technical Support.

User account passwords
During the migration, all user account passwords are reset to password. After 
migration, check the user accounts. As an Administrator, you can change 
password to a default password that complies with your organization’s user 
account policies.

Liquid class specifications
If no liquid class was specified in the VWorks3 software, the following VWorks3 
VPrep parameters are moved into the Liquid Library after migration:

• Aspirate velocity

• Aspirate acceleration

• Dispense velocity

• Dispense acceleration
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BioIO specifications
The BioIO specifications in the VWorks3 software are not migrated. After the 
migration process, you must add the BioCel I/O Interface device, create a 
profile for it, and set up the signal channels.

Vertical Pipetting Station shelves
Standard, Reagent, and Shaking shelves can be migrated. The following shelves 
will be converted to Standard shelves and must be reconfigured after the 
migration:

• Filter

• Servo

• Tipbox

• Tip Chute

JavaScript parameters
All tasks and parameters referenced in JavaScript are migrated with the 
following exceptions. After migration, make sure you check the JavaScript and 
make the necessary modifications manually.

• Print and Apply

• Deerac Fluidics Equator device, Execute Method

• Labcyte Echo 550 device

– Cherry Transfer

– NBSurvey

– Standard Transfer

• Tecan Freedom EVO device

– Run Script(SubProcess)

– Run Worklist(SubProcess)

• FLIPR Tetra device

– Run Protocol

– Load Tips

– Unload Tips

• Hamilton Microlab STAR device, Execute Method

Device names
Some devices have been renamed. During migration, the software will change 
the names in the migrated files, and the new names will appear in the VWorks 
software. Make sure you check the protocols and device files before running 
protocols.

Old name New name

Access2 Automated Microplate 
Loader

Automated Centrifuge Loader, or 
Centrifuge Loader

Bio IO BioCel I/O Interface

Delid Station (Vacuum), Tip Box 
Delidder

Vacuum Delid Station

PlatePierce Seal Piercing Station Microplate Seal Piercer

Shuttle Robot Microplate Rotator Shuttle
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Tasks not supported by the VWorks software
The following tasks are currently not supported in VWorks software:

• Fill Plate (VPrep)

• DryTips (VPrep)

• PrePostMix (VPrep)

• Dispense (Genetix QFill)

• Run Program (Nanodrop)

• Seal (Remp CSP)

• Read Plate (Ultramark)

• Toggle door (Door)

• PrePostWellmate (Wellmate)

• Read Plate (Zeiss)

Parameters not supported by the VWorks software
The VCode Print and Apply PLUGIN parameter is not supported in the VWorks 
software.

Treatment of excluded devices in the VWorks3 Incubate task
After migration, an Incubate task will list all devices referenced by the device 
file in the Available Devices list. The devices that were specifically excluded in 
the original VWorks3 task will not appear in the list.

Other migration notes
The software allows you to migrate a protocol file that is not associated with a 
device file. However, you must associate the migrated protocol with a device 
file before running it.

VCode Barcode Print and Apply 
Station

Microplate Barcode Labeler

Velocity11 Conveyor Microplate Conveyor

Velocity11 Phantom Human Robot Phantom Robot

Velocity11 Robot 3- Axis Robot

VMix Mixing Station Mixing Station

VPrep Pipetting System Vertical Pipetting Station

VShuttle Rotating Microplate Mover Rotator

VSpin Microplate Centrifuge Microplate Centrifuge

VStack Labware Stacker Labware Stacker

Old name New name
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Migrating protocols

To migrate a single protocol file:

Note: Existing protocols are not affected by this procedure.

1 Start the VWorks software. 

 IMPORTANT If this is the first time you are starting the VWorks 
software on this computer, a dialog box displays informing you that 
some settings from the previous version of software was found and asks 
if you want to migrate these settings. This refers only to global settings, 
not protocols. 

2 Select File > Open.

3 Locate and select the protocol, then click Open. 

4 Click OK to the warning message explaining that you are opening a 
protocol created in an older version of VWorks. 

5 Navigate to a folder, or create a new one for the migrated protocols and 
click OK. 

The migration starts. All associated files (device, profiles, teachpoints, 
labware definitions, liquid definitions) are migrated and the new files 
appear in the newly created destination folder. 

When the migration is completed, a message is displayed informing you if 
the migration was successful and any warnings that were encountered 
during the migration. An example is shown below:

CAUTION  Before you migrate to VWorks software, back up all of your profiles, device 
files, and protocols.
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Click OK to close the message box.

6 In VWorks software, check the Log area for error messages. 

VWorks software notifies you of any changes to task parameters that 
occurred during the development of VWorks software. For example, auto 
tip tracking is now available in VWorks software but was not in VWorks3 
software.

7 Verify the protocol is intact and start using any of the new task 
parameters now available in VWorks software.

8 Save the new protocol file.

To migrate a number of protocols stored in one folder:

1 Start the VWorks software.

 IMPORTANT If this is the first time you are starting VWorks software 
on this computer, a dialog box displays informing you that some settings 
from the previous version of software was found and asks if you want 
to migrate these settings. This refers only to global settings, not 
protocols. 

2 Select Tools > Migrate all files in a folder. The Migrate All Files in One folder 
dialog box opens.

3 Select the source and destination folders and click OK.

The migration starts. All associated files (device, profiles, teachpoints, 
labware definitions, liquid definitions) are migrated and the new files 
appear in the newly created destination folder. 
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4 When the migration is completed, a message is displayed informing you if 
the migration was successful and any warnings that were encountered 
during the migration. An example is shown below:

Migrating profiles

When protocols are migrated from an older version of the VWorks software, 
the profiles are automatically migrated unless there is a naming conflict. 
VWorks software installs some default profiles. These profiles may have the 
same name as ones you created in previous version of the VWorks software. If 
so, when starting the VWorks software the first time, you may see a dialog box 
such as the following:

Related information

For information about... See...

Different file types and how they 
are related

VWorks Automation Control User 
Guide

Setting up user accounts “Managing user accounts” on page 101

Devices supported by the VWorks 
software

VWorks Automation Control User 
Guide
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Adding the BioCel I/O Interface 
and setting up digital signals

BioCel System User Guide

For information about... See...
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2
Defining labware

This chapter contains the following topics:

• “About defining labware with the Labware Editor” on page 16

• “Labware Editor overview” on page 17

• “Workflow for defining labware” on page 20

• “Opening the Labware Editor” on page 21

• “Adding a labware entry” on page 24

• “Setting general properties” on page 26

• “Setting plate properties” on page 27

• “Setting Vertical Pipetting Station properties” on page 31

• “Creating and assigning labware classes” on page 33

• “Using labware classes example” on page 35

• “Adding a labware image” on page 38

• “Setting Centrifuge Loader properties” on page 39

• “Setting BenchCel Workstation properties” on page 40

• “Setting Bravo Platform properties” on page 45

• “Setting Stacker properties” on page 46
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About defining labware with the Labware Editor

Labware defined

Labware is a physical object such as a plate, lid, or tip box that will be acted 
upon by the tasks stored in your protocol.

VWorks software requires all labware to be handled by the automation system 
defined in the labware database.

Labware entry defined

A labware entry is the collection of property values used to describe a piece of 
labware. This information is used by VWorks software to command the robot 
and other devices to do tasks based on the information in the definition.

All labware parameters are entered and accessible through the Labware Editor.

Labware Editor defined

The Labware Editor is the VWorks software interface through which you can 
enter information about labware.

You must be logged in as an administrator or technician to use the Labware 
Editor.

Types of information stored

Two main types of information are stored in the labware database:

• Information about the labware properties

• Information about labware classes

About labware properties

Labware has physical properties such as width, length, and number of wells. 
Labware can also have non- physical properties, such as robot- handling speed, 
offsets, and plate- handling options.

With the Labware Editor, all you have to do is select the type of labware to 
use each time you set up a protocol.

About labware classes

Labware classes are sets of labware entries, grouped so they are easier to 
manage than many individual labware entries.

Labware classes are used in combination with the device manager to restrict 
which types of labware can be used on which devices during a protocol run. 
This prevents wasted runs and damage to the devices on the platform.

An example of how damage can be prevented by labware restriction is where a 
tipbox that is too tall for a device crashes into the device as the robot delivers 
it. 



17

2   Defining labware
Labware Editor overview

VWorks Automation Control Setup Guide

Last Modiified: February 23, 2009 11:16 am

Related information

Labware Editor overview

Labware Editor pages

The Labware Editor has two tabs at the top of the screen:

• Labware Entries. The tab contains labware definitions

• Labware Classes. The tab contains a list of labware classes and the 
labware entries for each class 

Labware Entries page

Sub-pages
The Labware Entries tab contains the following tabs at the bottom of the 
screen:

• Plate Properties

• Pipette/Well Definition 

• Labware Classes

• Image

• Loader

• BenchCel

• Bravo

• Stacker

Labware selection box
The labware selection box, which is the left- hand column, is used to select a 
labware entry that you want to edit.

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Overview of the Labware Editor “Labware Editor overview” on page 17

Opening the Labware Editor “Opening the Labware Editor” on 
page 21
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Labware-Entry General Properties area
The Labware- Entry General Properties area displays the labware- entry general 
properties whose selections apply across all sub- tabs.

Labware Classes page

In the Labware Classes page, you create labware classes and assign defined 
labware to a labware class.
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Related information

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Using the Labware Editor “About defining labware with the 
Labware Editor” on page 16
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Workflow for defining labware

Labware standards and considerations

IMPORTANT All labware used with Agilent Technologies products must 
conform to the American National Standards Institute (ANSI) microplate 
standards. This includes deepwell and PCR plates. A group within the Society 
for Biomolecular Sciences (SBS) recommends and maintains the standards. 
Visit www.sbsonline.org for more information, or contact your labware's 
manufacturer.

Vertical Pipetting Station users. In addition to the ANSI standards for 
labware, Vertical Pipetting Station shelves 1 and 2 have a height restriction to 
ensure clearance for the pipette head. The maximum height of the labware that 
you can use on shelves 1 and 2 is dependent on several factors, such as the 
type of pipette head, tip size, and type of shelf. 

Note: The software displays an error message if you select a labware definition 
that exceeds the maximum allowable height for shelves 1 and 2. 

Workflow

This topic provides the sequence of steps for defining labware for devices that 
use VWorks software.

Note: Some of these steps may be omitted, depending on your system 
configuration.

Step For this task... See...

1 Add the labware entry to the 
Labware Editor

• “Opening the Labware Editor” 
on page 21

• “Adding a labware entry” on 
page 24

2 Specify the general properties 
of the labware

“Setting general properties” on 
page 26

3 • Specify the plate properties 

• Specify robot gripper offset 
(for BioCel System robots)

“Setting plate properties” on 
page 27

4 Specify Vertical Pipetting 
Station properties

“Setting Vertical Pipetting Station 
properties” on page 31

5 Assign the labware to a class “Creating and assigning labware 
classes” on page 33

6 Add a labware image “Adding a labware image” on 
page 38

7 Specify robot gripper offset if 
using a Centrifuge Loader

“Setting Centrifuge Loader 
properties” on page 39
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Related information

Opening the Labware Editor

About this topic

This topic explains how to open the Labware Editor. 

You open the Labware Editor when you want to:

• View existing labware entries or classes

• Edit labware entries or classes

• Add new labware entries or classes

• Delete labware entries or classes

• Rename labware entries or classes

Before you start

You must be logged in as an administrator or technician to open the Labware 
Editor.

If you are adding labware, make sure you have the following:

• Calipers

• Two samples of the labware you are adding

8 Specify the robot and stacker 
gripping positions for BenchCel 
Workstations

“Setting BenchCel Workstation 
properties” on page 40

9 Specify Bravo Platform 
properties

“Setting Bravo Platform properties” 
on page 45

10 Specify Stacker gripper and 
sensor settings and any plate 
notch positions

“Setting Stacker properties” on 
page 46

Step For this task... See...

For information about... See...

Overview of the Labware Editor “Labware Editor overview” on page 17

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Using the Labware Editor “About defining labware with the 
Labware Editor” on page 16
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Procedure

You can open the Labware Editor from the Tools menu, protocol editor, or 
device diagnostics.

To open the Labware Editor from the Tools menu:
Click Tools > Labware Editor.

To open the Labware Editor from the protocol editor:

1 Open a protocol file (File > New > Protocol or File > Open). This opens the 
Main Protocol area with Process- 1 and a list of Plate properties in the 
Task Parameters area. 

Note: If the Task Parameters area is empty, click Add Process in the Main 
Protocol area.

2 Select Edit labware from the Plate type list under Plate identity. 

The Labware Editor dialog box opens.



23

2   Defining labware
Opening the Labware Editor

VWorks Automation Control Setup Guide

Last Modiified: February 23, 2009 11:16 am

To open the Labware Editor in device diagnostics:

1 Open the device file that contains the device.

2 Select the device icon in the Devices area.

3 Click Device diagnostics.

4 Refer to the using diagnostics section of the device user guide for location 
of the Labware Editor access.

Related information

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Adding a labware entry “Adding a labware entry” on page 24

Using the Labware Editor “Labware Editor overview” on page 17
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Adding a labware entry 

Before you start

You must be logged in as an administrator or technician to perform this 
procedure.

Before you add a new labware entry:

• Check to see if it is already defined in the Labware Editor. 

Some common labware and some Agilent Technologies labware comes 
already defined in VWorks software.

• Contact Automation Solutions Technical Support with the definition you 
need.

Automation Solutions Technical Support maintains a large collection of 
labware definitions and might be able to supply you with what you need. 
However, these labware definitions will still require some fine- tuning for 
each particular system. The generic definitions available for some plate 
types are a good starting point.

To find out if a type of plate is already defined:

1 In VWorks software, click Main Protocol, and select the plate icon in a 
process.

2 In the Plate identity area, click the down arrow on the list box and look for 
the name of the plate.

If there is no entry for the plate, it is not defined.

Procedure

To add a labware entry:

1 Open the Labware Editor dialog box.
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2 Under the labware selection area on the left side of the window, click New 
labware entry.

Note: You can save a lot of time by first checking to see if there's a 
similar piece of labware already defined. Click Save changes as and enter 
a name for the new labware.

3 In the New Labware Entry dialog box, enter a name for the plate and click 
OK.

For clarity, enter a detailed name for the labware that includes the 
manufacturer’s name and plate- specific information.

The entry appears in the labware selection area.

Related information

For information about... See...

Using the Labware Editor “About defining labware with the 
Labware Editor” on page 16

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21
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Setting general properties

About general properties

The general properties describe the type of labware that is being entered into 
the database and are visible on all of the sub- tabs of the Labware Editor.

Before you start

• You must be logged in as an administrator or technician to perform this 
procedure.

• You must first create an entry for the labware.

Procedure

To define the general properties of a piece of labware:

1 Open the Labware Editor dialog box.

2 Select the labware in the left column.

3 In the Description text box, type in a detailed description of the labware.

4 For your reference, in the Manufacturer part number text box, enter the 
appropriate number. 

5 In the Number of wells list, select the number of wells in the plate. 

If you are defining a tip box, this is the number of tips that the box can 
hold.

6 In the Base Class area, select one of the options.

The option you select determines which Labware Editor properties are 
available. For example, when a base class of Microplate is selected, the 
Length of filter tip/pin tool (mm) property is unavailable.

Note: The pin tool is not available for the Bravo Automated Liquid 
Handling Platform.

Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Setting plate properties for 
labware

“Setting plate properties” on page 27
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Setting plate properties

Before you start

You must have a technician or administrator user account to perform this 
procedure.

Setting plate properties

To set plate properties:

1 Open the Labware Editor dialog box.

2 Click the Plate Properties sub- tab.

3 Enter the values for the available parameters according to the type of plate 
or labware you are defining. 

The parameters on the Plate Properties tab are described in the following 
screenshot and table. 

Note: The Base Class you select in the General Properties section will 
determine which plate property parameters are available.
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Property Description

Robot 
gripper 
offset

Applies to BioCel Systems only.

The height, in millimeters, of the gripper above any 
teachpoint when the VWorks software is picking up or 
placing a plate of this type. The value is typically 0–3 
mm.

Note: The offset could be a negative value, indicating it is 
below the teachpoint.

This property is used by VWorks software when running 
protocols. The similar gripper offset property in the 
VWorks software Diagnostics performs the same function 
when picking and placing using Diagnostics software.

Thickness The distance, in millimeters, from the bottom surface of 
the plate to the top surface of the plate.

For a tip box, this is the distance from the bottom 
surface of the box to the top of the tips.

To increase the number of contact points, measure the 
distance at the corner of the plate or tip box (using 
calipers). This method is especially useful if the plate has 
a lip at the top and the caliper can angle inward, 
producing inaccurate measurements.

Stacking 
thickness

The thickness, in millimeters, of two stacked plates minus 
the thickness of one plate.

Measure the distance using calipers.

Example:

Thickness of two stacked plates (x) = 23.14 mm

Thickness of one plate = 14.14 mm

Stacking thickness: 23.14 mm -  14.14 mm = 9.00 mm

Shim/nesting 
thickness

The distance between the bottom of the microplate skirt 
and the exterior bottom of the wells. (Shown as c below.)

Vstack
plate and stacking thickness
00022

Plate Thickness

Stacking Thickness

x

00022

Skirt C
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Can be 
sealed?

The option to include the plate seal. 

Sealed 
thickness

The thickness, in millimeters, of the plate with a seal in 
place.

Available only if Can be sealed? is selected.

Sealed 
stacking 
thickness

The stacking thickness, in millimeters, of the plate with a 
seal in place.

Available only if Can be sealed? is selected.

Can have 
lid?

The option to include a plate lid.

Lidded 
thickness

The thickness, in millimeters, of the plate with a lid in 
place.

Available only if Can have lid? is selected.

Lidded 
stacking 
thickness

The stacking thickness, in millimeters, of the plate with 
the lid in place.

Available only if Can have lid? is selected.

Lid gripper 
offset

The height, in millimeters, above the lid resting height at 
which to grip the lid. (Shown as b below.)

Lid resting 
height

The height, in millimeters, above the bottom of the plate 
at which the bottom of a plate lid rests. (Shown as a 
below.)

Lid 
departure 
height

The height, in millimeters, above the bottom of the plate 
to which the lid is lifted.

Lower plate 
at Microplate 
Labeler

The option to lower the plate on the stage of the 
Microplate Labeler, if the plate has a thick skirt. This 
allows the Microplate Labeler to place the label above the 
thick skirt.

Property Description

b

a

c
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Related information
 

Can mount The option to place this plate on top of another plate.

This property is for filter plates that are placed on top of 
waste plates during filtration steps of a protocol.

This option can also be used to mount lids onto plates.

Can be 
mounted

The option to place another plate on top of this plate.

This property is for collection plates that collect filtrate 
from filter plates during the filtration steps of a protocol. 
Many different plates might be able to fit under any one 
type of filter plate. 

IMPORTANT The wells of the waste plate must have a 
large enough diameter that the filter plate does not stick 
on the waste plate. The robot must be able to pick up the 
filter plate without the waste plate lifting up with it.

This option can also be used to mount lids onto plates.

Maximum 
robot 
handling 
speed

The maximum speed at which this type of plate should 
be moved.

The general robot speed is set in VWorks software. If the 
plate- specific robot speed (set here) is different from the 
general robot speed, the slower of the two speeds is used.

Length of 
filter tip/pin 
tool

The length, in millimeters, the filter nozzle extends below 
the bottom edge of the skirt. Use a caliper to measure 
the length.

Requires 
insert

The option to require an insert for use with nestable tip 
boxes.

Property Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26
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Setting Vertical Pipetting Station properties

When to set the pipette/well properties

The values on the Pipette/Well Definition sub- tab must be set when VWorks 
software is controlling a Vertical Pipetting Station. 

Setting properties

To set pipette/well properties:

1 Click the Pipette/Well Definition sub- tab of the Labware Editor.

2 Enter the values for the available parameters according to the type of plate 
or labware you are defining. 

The properties on the Pipette/Well Definition sub- tab are described in the 
following screenshot and table. 

Use calipers to carefully measure the labware you are defining in the 
Labware Editor.

Property Description

Well volume Maximum volume of fluid for one well, in 
microliters.

Well depth Distance from the top of the plate to the bottom of 
the well, in millimeters.

Well diameter Diameter of the well, in millimeters.

Well Geometry Shape of the wells: round or square.

Well- Bottom Shape Shape of the well bottoms: rounded, flat, or V-
shaped.
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Related information

Row- wise 
teachpoint to well

Distance from the teachpoint to the center of the 
A1 well along the row (letter axis), in millimeters. 

This setting should be 0 mm for standard 96- well 
plates and 2.25 mm for standard 384- well plates.

Column- wise 
teachpoint to well

Distance from the teachpoint to the center of the 
A1 well along the column (number axis), in 
millimeters. 

This setting should be 0 mm for standard 96- well 
plates and 2.25 mm for standard 384- well plates. 

Row- wise well to 
well

Distance from well- center to well- center across the 
row, in millimeters. 

This setting should be 9 mm for standard 96- well 
plates and 4.5 mm for standard 384- well plates. 

Column- wise well 
to well

Distance from well- center to well- center across the 
column, in millimeters. 

This setting should be 9 mm for standard 96- well 
plates and 4.5 mm for standard 384- well plates. 

Disposable tip 
capacity

Volume capacity of the disposable tips, in 
microliters, when labware is a tip box. 

Disposable tip 
length

Length of the disposable tips being used, in 
millimeters, when labware is a tip box.

Property Description

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26

Setting plate properties for 
labware

“Setting plate properties” on page 27
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Creating and assigning labware classes

About labware classes 

When you configure a device for the VWorks software, you can associate the 
device with labware classes to indicate what labware can (and cannot) be used 
with the device. Associating a device with a labware class is performed in the 
device file under the Allowed/prohibited labware property.

For example, if you have a Microplate Vacuum Alignment Station on a Bravo 
platform, you might want to set up a labware class from which tube racks are 
excluded. (Most types of tube racks will cause an error on the Microplate 
Vacuum Alignment Station).

VWorks software is provided with six labware classes already defined: 

• Uses Filter Platepad

• Uses Standard Platepad

• Uses Taller Plate

• Uses Tip Box

• Uses Vacuum Delidder

• Uses Vacuum Platepad

These default classes should be enough for your plate handling needs. However, 
if you want an additional special class that is excluded from a particular 
device or set of devices, you can create a new class.

About creating and assigning labware classes

The Labware Classes tab is used to create and manage labware classes and 
labware entry membership. 

The Labware Classes tab is located in the Labware Editor dialog box. To open, 
click Tools and select Labware Editor.

Select a class (in the left- most column) to see the labware entries that are 
members and non- members for that class (right two columns). In the example 
below, the class Uses Filter Platepad is selected and the labware that are 
members and non- members of this class are displayed.
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Creating labware classes

To create a new labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab, click New labware class.

3 In the New Labware Class dialog box, enter a name for the labware class and 
click OK.

The class appears in the list of labware classes. 

Note: You can also create a new labware class by clicking Save changes as and 
entering a different name.

Assigning labware classes

To associate a specific piece of labware with a labware class:

1 Open the Labware Editor.

2 In the Labware Classes tab select an item from the middle column.

3 Click > to move the labware entries or labware classes to the right- hand 
column.
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To select more than one item, use SHIFT- click or CTRL + click. If you want 
to move all entries, click > >. 

4 Click Save Changes to save your changes. 

Note: You can also assign labware to a class using the Labware Classes tab at 
the bottom of the Labware Editor. This may be more convenient when you are 
defining a new piece of labware and want to assign it to an existing labware 
class.

Related information

Using labware classes example

About this topic

This topic provides an example of how to use labware classes in conjunction 
with a device. 

The example

You have configured shelves 2, 4, and 6 of a Vertical Pipetting Station as 
devices that are accessible by the system’s robot. You are using a mix of plates, 
some of which are too tall to fit on shelf 2. By using labware classes, you will 
ensure that the robot will never try to place the wrong type of labware on 
shelf 2.

The labware has been defined and added to the Labware Editor but it still has 
the default settings for class membership. 

Assigning the labware

The first task is to assign the tall labware to the appropriate labware class.

To assign the labware:

1 Open the Labware Entries tab of the Labware Editor.

2 Select the labware from the list. The classes that the labware are and are 
not a member of is displayed.

3 Select Uses Taller Plates from the All labware classes area.

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

An example demonstrating the use 
of labware class

“Using labware classes example” on 
page 35
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4 Move it to the Labware classes that this labware entry belongs to area by clicking 
the  > arrow.

5 Click Save changes.

Setting restrictions for shelf 2

The next task is to restrict shelf 2 from using any labware that is a member of 
the Uses Taller Plates class.

To restrict shelf 2:

1 Open the Device File.

2 Select Shelf 2 from the Devices list.

3 Click in the cell next to Allowed/prohibited labware in Shelf 2 location Properties. 
The Allowed/Prohibited Labware Classes for Shelf 2 dialog box opens.

4 Select Uses Taller Plates in the Unassigned labware classes area and move it to 
the Labware classes prohibited... area using the left arrow (<).

5 Click OK.
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Related information

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Labware classes “Creating and assigning labware 
classes” on page 33
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Adding a labware image

About labware images

To make it easier for operators to identify a labware type, you can insert an 
image of it in the Labware Editor.

Before you start

Make sure the image file you want to add is either the JPG, GIF, or BMP 
format.

Procedure

To insert an image:

1 Open the Labware Editor.

2 Select the labware in the left column.

3 Click the Image sub- tab of the Labware Editor. 

4 Click the ellipsis button (...), and navigate to the folder location of the 
image file.

5 Double- click the image file.

The image appears below the file name.

6 Click Save changes.
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Related information

Setting Centrifuge Loader properties

When to set Loaderproperties

Enter values on this page of the Labware Editor if you are operating a 
Centrifuge with an Centrifuge Loader.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Loader properties:

1 Click the Loader tab of the Labware Editor.

2 Enter the Robot gripper offset (in millimeters). This specifies the distance 
from the bottom of the plate.

3 Optional. Select Ignore plate sensor during pick and place. You might want to 
ignore the plate sensor if you are using black plates whose finish and 
skirts sometimes causes them to avoid detection.

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Using the Labware Editor “Labware Editor overview” on page 17

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Using the Labware Editor “Labware Editor overview” on page 17
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Setting BenchCel Workstation properties

About the BenchCel Workstation properties

The BenchCel Workstation X- Series and R- Series each have their own gripper 
offsets and positions. When you add a new labware entry, default property 
values are automatically inserted for both series. These values are approximate 
and should be ignored because the labware you are defining may be different.

Any labware that you are using with the X- Series will need to be redefined to 
work with the R- Series BenchCel Workstation because the property values are 
different for the same piece of labware. 

Note: You must also define a subset of the Stacker properties (under the 
Stacker sub- tab) because they apply to the built- in stackers of the BenchCel 
Workstation.

Procedure

To define the BenchCel Workstation properties:

1 Open the Labware Editor dialog box.

2 Click the BenchCel tab.

3 Click the button that corresponds to the BenchCel Workstation type that is 
currently operating and for which you are defining the labware.

IMPORTANT Make sure you are entering data for the correct BenchCel 
Workstation type. Fields for X- Series and R- Series BenchCel Workstations can 
be enabled regardless of the type of BenchCel Workstation that you are 
operating.

4 Measure the labware and enter the values into the appropriate fields.

The properties on the BenchCel tab are described in the following 
screenshot and table. All of the properties on this tab apply to the 
BenchCel Workstation.
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Click the button to enable the text fields

Property Description

Robot gripper offset The distance, in millimeters, from the 
bottom of the plate to the point where the 
grippers grip the plate. Typically this value 
is 6–10 mm.

IMPORTANT Make sure that the gripper 
points are not closing near the very edge 
of the skirt causing some of the gripper 
points to slip onto the body of the plate 
and the plate to be dropped.

Note: The robot gripper offset that appears 
on the Plate Properties page applies to 
Agilent Technologies robots used in BioCel 
Systems, not BenchCel Workstation robots.

Gripper open position The distance, in millimeters, that each 
gripper moves from its home position as 
the robot releases a microplate. An larger 
value moves the grippers closer together. A 
smaller value opens the grippers wider.

The parameter value is applied to both 
robot grippers. For example, a value of  
–1.00 mm opens each robot gripper  
–0.50 mm from its home position.

Set this to –1 for R series and 0.1 for X 
Series BenchCel Workstations.
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Gripper holding plate position The distance, in millimeters, that the 
grippers move inward from their home 
position when holding a microplate that is 
not in a stack. A larger value moves the 
grippers closer together and holds the 
microplate tighter. A smaller value opens 
the grippers wider.

The parameter value is applied to both 
robot grippers. For example, a value of 
5.25 mm moves each robot gripper 2.625 
mm toward each other from its home 
position.

Note: How tightly the robot grippers should 
hold a microplate depends on the 
microplate material and design. You might 
want to run some tests to optimize the 
parameter.

Gripper holding lidded plate 
position

The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a lidded microplate. 

An increasing value moves the grippers 
closer together and holds the lidded 
microplate tighter. A decreasing value 
opens the grippers wider.

Gripper holding lid position The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a microplate lid. An 
larger value moves the grippers closer 
together and holds the microplate tighter. 
A smaller value opens the grippers wider.

The parameter value is applied to each 
robot gripper. For example, a value of 5.25 
mm moves each robot gripper 2.625 mm 
toward each other from its home position.

In general, type a value that is less than 
Gripper holding plate position to open the 
grippers slightly. Holding the lid too tightly 
might cause the microplate to be lifted 
with the lid.

Property Description
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Gripper holding stack position The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a microplate that is 
in a stack. An increasing value moves the 
grippers closer together and holds the 
microplate tighter. A decreasing value 
opens the grippers wider.

The parameter value is applied to both 
robot grippers. For example, a value of 
5.25 mm moves each robot gripper 2.625 
mm toward each other from its home 
position.

Note: Because the weight of the entire 
stack will be on the robot grippers, you 
should use a value greater than the 
Gripper holding plate parameter.

Stacker gripper offset Adjusts the height at which the stacker 
grippers will grab the plate. This distance 
is measured in millimeters from the 
bottom of the plate. 

Be careful not to grab the plate on the top 
edge of the skirt where the stacker 
grippers could slip onto the plate body.

Change this value only if the stacker is not 
gripping the plates correctly.

Orientation sensor offset The distance, in millimeters, from the 
bottom of a microplate to where the 
orientation sensors will check for notches.

Agilent Technologies recommends that you 
calculate the offset as follows: Determine 
the halfway distance between the top of 
the microplate and the top of the 
microplate skirt, and then add the height 
of the skirt.

Property Description

Divide this height by 2

Add the skirt height
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Related information

Stack holding method (R-
Series only)

Determines how the stacker holds the 
stack of plates.

Holding the stack with grippers is more 
precise and slower than holding the stack 
with a shelf.

Choose Hold with stacker gripper if your 
plate has a narrow gripping tolerance 
requiring a specific stacker gripper offset.

Choose Hold with shelf if your plate has a 
wider gripping tolerance and does not 
require a specific stacker gripper offset.

Note: Cycle time is faster with the shelf 
method.

Property Description

For information about... See...

Using the Labware Editor “Labware Editor overview” on page 17

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Setting general properties for 
labware

“Setting general properties” on page 26
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Setting Bravo Platform properties

When to set Bravo properties

Enter values on this page of the Labware Editor if you are operating a Bravo 
Platform that has a robot gripper.

Note: The Bravo robot gripper is an optional feature.

You must be logged in as an administrator or technician to perform this 
procedure.

Procedure

To set Bravo Platform properties:

1 Click the Bravo tab of the Labware Editor.

2 Enter the Robot gripper offset (in millimeters). This is the height of the 
gripper above any teachpoint when the Bravo gripper is picking up or 
placing a plate of this type.

3 Enter the Robot lid gripper offset (in millimeters). This is the height, in 
millimeters, above the lid resting height at which to grip the lid. (Shown as 
b below.)

4 Select Ignore plate sensor during pick and place to tell the robot gripper to 
ignore the feedback from the plate sensor during a pick and place for this 
labware. Typically, this is selected when troubleshooting.

Related information

b

For information about... See...

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20
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Setting Stacker properties

When to set Stacker properties

If you are using Stacker or a BenchCel Workstation in your automation system, 
you must specify the properties on this page of the Labware Editor. For 
BenchCel Workstation users, not all of the information is required (see below).

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start

BenchCel Workstation users. Make sure you have read the portions of the 
BenchCel Microplate Handling Workstation User Guide that describes the 
location and function of the stacker sensors.

Setting properties

To set stacker properties:

1 Click the Stacker tab of the Labware Editor.

2 Enter the values for the available parameters according to the type of plate 
or labware you are defining. 

The properties on the Stacker sub- tab are described in the following 
screenshot and table. 

For BenchCel Workstations, you only need to set the maximum orientation 
sensor threshold, sensor intensity and notch locations. The other settings 
are used by the Stacker.

Using labware classes “Creating and assigning labware 
classes” on page 33

For information about... See...
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Set these properties for 
BenchCel stackers

Property Description

Stacker only. Stacker gripper 
offset 

Adjusts the height at which the plate 
stage stops for the grippers to grip the 
plate, with respect to the Stacker’s grip 
teachpoint.

Change this value only if the stacker is 
not gripping the plates correctly.

Stacker only. Presentation 
offset 

You should never need to change this 
value.

Adjusts the height of the Stacker plate 
stage with respect to the presentation 
teachpoint of a Stacker.

Stacker only. Orientation 
sensor offset

Adjusts the height at which the 
orientation checking sensors view the 
plate, with respect to the sensor.

Orientation sensor threshold 
(max)

Specifies the highest value that an 
orientation sensor can register when 
sensing a notch. Any sensor reading 
above this value indicates that a solid 
plate wall is present. Any sensor value 
below this threshold indicates that either 
a notch, or no plate is present.

If the stacker does not sense a notch 
when it should, you will get a “wrong 
plate type” or a “plate rotated 180 
degrees” error message. Adjust the sensor 
threshold value.

The maximum value is 255.
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Stacker only. Orientation 
sensor threshold (min)

Specifies the lowest value that an 
orientation sensor can register and still 
consider a notch to be present. If the 
orientation sensor returns a value below 
this threshold then no plate is present.

If the stacker does not sense a notch 
when it should, you will get a “wrong 
plate type” or a “plate rotated 180 
degrees” error message. Adjust the sensor 
threshold value.

Sensor intensity Sets the percentage of maximum sensor 
intensity for all sensors. If the sensor 
intensity is set too low, a plate will not 
be detected even though one is present. If 
it is set too high, the sensors might 
become saturated, causing failure to 
detect the orientation of a plate.

This property adjusts for the fact that 
clear, black, and white plates reflect light 
differently. For example, white plates 
generally reflect more light so the sensor 
intensity should be set lower. 

Use vacuum clamp Instructs theStacker you are using a 
vacuum clamp in the Stacker stage to 
grasp the plate during delidding.

Notch locations Select the corresponding notch or notches 
for your plate in the Notch Locations 
area.

For BenchCel Workstations, the A1 well 
of the plate is positioned in the far, left 
corner as you face the BenchCel 
Workstation.

For BioCel Systems, the A1 well of the 
plate is positioned in the far, left corner 
from the perspective of the robot.

Check orientation Turns on plate- orientation checking.

The notch locations are ignored when 
this option is cleared.

Property Description

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Notches
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Related information

For information about... See...

Workflow for adding labware to 
the Labware Editor

“Workflow for defining labware” on 
page 20

Opening the Labware Editor “Opening the Labware Editor” on 
page 21

Using the Labware Editor “Labware Editor overview” on page 17
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3
Specifying pipette speed and accuracy

This chapter contains the following topics:

• “About liquid classes” on page 52

• “Opening the Liquid Library Editor” on page 54

• “Creating a liquid class” on page 55

• “Calibrating the pipettor” on page 58
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About liquid classes

Liquid Library Editor defined

The Liquid Library Editor is a dialog box through which users with technician 
or administrator privileges can enter values for properties that affect pipetting 
speed, accuracy, and precision. 

Default liquid library entries

When installing VWorks software, you might have elected to install the default 
liquid library entries. These entries are provided as examples and thus might 
only approximate your particular reagents. For the best performance, you 
should create your own liquid library definitions.

When to use the Liquid Library Editor

You open the Liquid Library Editor when you want to:

• View the properties that are defined for a liquid class

• Edit the properties that are defined for a liquid class

• Add new liquid classes

IMPORTANT You should verify the pipetting of your Vertical Pipetting Station 
or Bravo Platform. Accurate and precise pipetting depends on a variety of 
factors including the liquid properties. Use the Liquid Library to fine- tune the 
volume delivered.

Liquid classes defined

The values entered into the Liquid Library Editor can be saved as a collection, 
known as a liquid class. Using liquid classes saves time when writing protocols 
because you do not have to enter values for the liquid properties every time 
you create a protocol.

Types of liquid classes 
You might want to create different classes for different:

• Types of liquids

For example, water versus DMSO

• Volumes of liquids

For example, 1 µL versus 200 µL

• Liquid operations

For example, washing versus mixing

Liquid library database defined

The data that represents a liquid class is saved to the liquid library database, 
which is maintained in the Windows registry.
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Using a liquid class

When preparing for a protocol run, you select the liquid class that you want to 
use. During the run, the liquid class values are referenced for pipetting 
operations.

Calibrating the Bravo Platform and Vertical Pipetting Station

The Liquid Library Editor also has an equation editor that can be used to 
calibrate the Bravo Platform and Vertical Pipetting Station.

Liquid Library Editor dialog box

A screenshot of the Liquid Library Editor follows.

Related information

For information about... See...

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 54

Creating a liquid class “Creating a liquid class” on page 55

Calibrating your pipettor “Calibrating the pipettor” on page 58
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Opening the Liquid Library Editor

Before you start

You must be logged in as an administrator or technician to open the Liquid 
Library Editor.

Procedure

To open the Liquid Library Editor from VWorks software:

1 Select Tools > Liquid Library Editor.

The Liquid Library Editor opens.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 52

Creating a liquid class “Creating a liquid class” on page 55

Calibrating your pipettor “Calibrating the pipettor” on page 58



55

3   Specifying pipette speed and accuracy
Creating a liquid class

VWorks Automation Control Setup Guide

Creating a liquid class

About this topic

This topic describes how to create a liquid class using the Liquid Library 
Editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Liquid compatibility

Procedure

To create a liquid class:

1 Open the Liquid Library Editor.

2 Click New liquid entry. 

3 In the New Liquid Entry dialog box, enter a name for the liquid class and 
click OK.

4 Optionally, in the text box at the top right, type a note describing the 
liquid library entry for your records.

5 Enter values for the aspirate properties.

The following table describes these properties.

Note: The upper limits for some of the properties might not be 
achievable for the device you are using.

WARNING  Agilent Technologies products are intended to be used with non-hazardous 
liquids. Please contact Automation Solutions Technical Support before using any non-
aqueous solvents or solvents generally considered to be hazardous. 

Aspirate property Definition

Velocity Specifies the speed of the 
aspiration stroke, in microliters 
per second.

Acceleration Specifies acceleration during the 
aspiration stroke, in microliters 
per second squared.
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6 Click the Dispense tab and enter values for the dispense properties.

The following table describes these properties.

Post- aspirate delay Specifies the time the pipettor 
waits after aspiration is complete 
before moving the tips out of the 
wells, in milliseconds.

Z- axis velocity into wells Specifies how fast the pipettor 
moves as the tips enter the wells, 
in millimeters per second.

Z- axis acceleration into 
wells

Specifies the acceleration of the 
pipettor as the tips move into the 
wells, in millimeters per second 
squared. 

Z- axis velocity out of wells Specifies how fast the tips leave 
the wells, in millimeters per 
second.

Z- axis acceleration out of 
wells

Specifies the acceleration of the 
pipettor as the tips move out of 
the wells, in millimeters per 
second squared. 

Aspirate property Definition

Dispense property Definition

Velocity Specifies the maximum speed 
of the dispensing stroke, in 
microliters per second.

Acceleration Specifies acceleration during 
the dispensing stroke, in 
microliters per second squared.

Post- dispense delay Specifies the time the pipettor 
waits after the dispense stroke 
before moving the tips out of 
the wells, in milliseconds.

Z- axis velocity into wells Specifies how fast the pipettor 
moves as the tips enter the 
wells, in millimeters per 
second.

Z- axis acceleration into wells Specifies the acceleration of 
the pipettor as the tips enter 
the wells, in milliliters per 
second squared.
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7 Click Save changes. 

The changes are now stored in the liquid library database.

Related information

Z- axis velocity out of wells Specifies how fast the pipettor 
moves as the tips leave the 
wells, in millimeters per 
second.

Z- axis acceleration out of wells Specifies the acceleration of 
the pipettor as the tips leave 
the wells, in millimeters per 
second squared.

Dispense property Definition

For information about... See...

Liquid classes “About liquid classes” on page 52

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 54

Calibrating your pipettor “Calibrating the pipettor” on page 58
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Calibrating the pipettor

About calibrating the pipettor

You can improve the accuracy of pipetted volumes by:

• Calibrating the pipettor

• Plotting the actual volume dispensed as a function of the set dispense 
volume

• Calculating the polynomial coefficients of the plot

• Entering the coefficients into the liquid library equation editor

Do you need to calibrate your pipettor?

Pipetting accuracy is the ability to dispense an absolute volume of liquid. In 
practice, the volume that is actually dispensed by a pipettor may be different 
from the dispense volume that you select. This difference is the absolute error.

In some protocols, as long as you dispense an excess of liquid, the actual 
volume pipetted is not important. In other protocols, pipetting accuracy can be 
a critical factor. You must remember, though, that every step of an experiment 
has error and there is no point taking time to improve the accuracy of 
pipetting to four significant digits if another step in your protocol has error at 
the third significant digit.

If you are sure that the overall error of the experiment is limited by pipetting 
accuracy, and error at this number of significant figures makes a practical 
difference to you interpretation of the data, consider performing an accuracy 
calibration.

Method overview

This section gives an overview of the method you can use to measure pipetting 
accuracy. It does not give a detailed procedure because that depends on 
exactly how you choose to conduct the experiment.

To calibrate a pipettor, an independent method of measuring dispensed volume 
is required. One method is to dispense a solution of fluorescein dye and 
measure the fluorescence emitted from each plate well.

IMPORTANT Whichever method you use, verify that the error in the detection 
method is significantly smaller than the pipetting error. Otherwise, the error 
you detect might be from the detection method and not the pipetting error.

The overall method is:

1 Perform a series of pipetting operations in which different volumes are 
pipetted.

2 Measure the volumes of dispensed liquid using the independent measuring 
method.

3 In a spreadsheet program, tabulate the dispense volumes that you set in 
the software against the measured volumes.

4 Plot a graph, with the set dispense volume on the y- axis and measured 
dispense volume on the x- axis.
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The plot will be a curve, reflecting the fact that absolute error is a 
function of the magnitude of the measurement.

5 Use the statistical functions of the spreadsheet program to fit a curve to 
the data.

Your result might look like this:

The dashed line is a reference line, where the set dispense volume equals 
the measured dispense volume. The equation is the polynomial for the line, 
calculated by the spreadsheet program.

6 Enter the curve information into the equation editor of the Liquid Library 
Editor.

If you repeat the experiment, you will find that the curve is much closer to a 
straight line. This is because the equation you entered adjusts the action of the 
servo motor that determines aspirate and dispense volumes, thereby calibrating 
the dispense.

Using the equation editor

The equation editor in the Liquid Library Editor is where you enter the 
calibration curve data to correct for pipetting inaccuracy.

To enter a polynomial into the equation editor:

1 Open the Liquid Library Editor.

2 Click the Equation tab to display the equation editor.

3 In the Highest order of polynomial text box, enter the value for the highest 
order of the polynomial.

This is the largest exponent in the equation and tells you how many terms 
are in the equation. For example, if the highest order of the polynomial is 
3, the equation will have the general form: y = a + bx +cx2 + dx3, where ‘x’ 
is the volume specified by any pipettor task that uses this liquid class. 
With an exponent of three, four rows are added to the equation editor 
table.

4 In the Coefficient/Term table, in turn, enter the coefficient and exponent 
for each of the terms in the equation, starting with the zero order term.

y = 9E-05x  + 0.0027x  + 1.0176x - 0.12373 2
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To enter a value, single- click the Coefficient table row twice. Note that the 
exponents are already entered for you and cannot be edited.

The following example is for the curve displayed in the previous graph.

5 Click Save changes.

Related information

For information about... See...

Liquid classes “About liquid classes” on page 52

Opening the Liquid Library Editor “Opening the Liquid Library Editor” on 
page 54

Creating a liquid class “Creating a liquid class” on page 55



61

VWorks Automation Control
Setup Guide

Agilent Technologies

4
Tracking and managing labware in 
storage

This chapter contains the following topics:

• “About labware inventory management” on page 62

• “Connecting to the inventory management database” on page 66

• “Opening the inventory editor” on page 67

• “About inventory groups” on page 68

• “Creating and managing location groups” on page 70

• “Creating and managing plate groups” on page 72

• “Loading labware into storage devices” on page 74

• “Moving labware between storage devices” on page 78

• “Unloading labware out of inventory” on page 81

• “Using a plate group to process plates” on page 83

• “Creating a plate group with a barcode input file” on page 88

• “Inventory editor views and filters” on page 90

• “Auditing plate volumes in the inventory editor” on page 92

• “Reinventorying the plate inventory” on page 94

• “Resolving plate inventory problems” on page 97
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About labware inventory management

About this topic

This topic provides the background information you need to understand how to 
use the plate inventory manager to track groups of plates moving into and out 
of a plate storage device.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX, Heraeus Cytomat PLC, or a Agilent Technologies Plate Hub 
Carousel and you are using, or want to set up, inventory management with a 
database. 

Before you start

Before starting to create protocols that use the storage device, make sure you 
have read the device driver user documentation for your particular storage 
device as well as “Resolving plate inventory problems” on page 97.

Barcode tracking versus inventory management

Barcode tracking
Barcode tracking without an inventory system is limited because the plate 
locations are stored in memory and are lost when you exit VWorks software. 

Inventory management
The inventory management system allows long- term tracking of plates as 
barcode data is permanently stored in a database. This is useful for lab 
automation systems with devices that store plates for a long time, such as a 
Heraeus Cytomat PLC and Liconic StoreX.

Required database

To use inventory management you must have an SQL database set up, either 
on the computer that runs VWorks software or a computer that is on the same 
local area network.

How plates are stored

The long- term storage devices supported by VWorks software store plates in 
cassettes and slots. A cassette is a vertical rack that has many slots, with each 
holding one plate.

Information that is stored

The inventory maintains a list of plates located in a long- term plate storage 
device.
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The information contained about each plate in the inventory includes:

• Device in which the plate is located

• Cassette and slot location of the plate

• Name of the group or location to which it belongs

• Labware type

• Any north- side, south- side, east- side, and west- side barcodes.

West side barcodes are tracked only if an optional barcode reader is used. 

• Volume of the wells in the plate

The list of plates in the inventory is displayed in the Inventory Editor dialog 
box. An example view is shown below.

The list of plates in the inventory is updated every time a plate is moved with 
a robot in to or out of a storage device so that at all times, the list is current.

Inventory manager

The Inventory Editor dialog box is where you manage the inventory. From here 
you can:

• Create plate groups

• Create location groups

• Review information about plates in a group

• Import groups from a barcode file

• Change the labware type associated with plates in the database

• Delete plates from the database

• Inventory the labware in a storage device

Plate groups and Location groups

With long- term storage devices, typically only a sub- set of the plates stored in 
the device is used in one protocol. You can set up two different types of plate 
sub- sets, called plate groups and location groups. Which you choose for a 
particular protocol depends on what you are planning to do.

Plate groups are a group of plates based on the unique database identifier for 
that plate.

Location groups are a group of slots that are not based on information in the 
plate database.



4   Tracking and managing labware in storage
About labware inventory management

64 VWorks Automation Control Setup Guide

Inventory management tasks

The following tasks are used with the inventory management system. These are 
the tasks that move labware in to and out of a storage device:

• Load

• Unload

• Incubate at plate storage device

About manually moving plates

Keeping the database synchronized
It is important to note that the database cannot track plates that you manually 
add, remove, or move. To keep the database synchronized with the storage 
device, load and unload the plate storage device robotically, or periodically 
reinventory the storage device.

Instead of manually adding plates to the storage device, write a protocol to 
downstack the plates and load them. Instead of manually removing plates from 
the storage device, write a protocol to unload the plates and upstack them.

If you must manually load and unload plates
If you must manually load and unload plates you will need to create a protocol 
to load or unload the exact plates that you are manually adding or removing 
and then run the simulator.

With an appropriate protocol, the simulated run accurately changes the plates 
listed in the database without actually moving any plates. 

Terminology

When describing the movement of plates, it is important to use terms correctly. 
The terms load and unload are used from the storage device’s perspective. 

Term Definition

Unload The act of moving a plate from a storage device into the system.

Load The act of moving a plate from the system into a storage device.

System Plates that are being processed by the current protocol are 
considered to be in the system.

For example:

• A plate on a platepad is in the system.

• A plate in a plate hotel is in the system.

• A plate being incubated in an incubator is in the system.

• A plate half- way up a Stacker rack is not in the system, 
unless it will be moved during the current protocol.

• A plate being stored in a Plate Hub Carousel is not in the 
system unless it will be moved during the current protocol.
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Database backup

The inventory management database can be backed up onto another computer 
using a software utility. If you want to do this, contact the Automation 
Solutions Technical Support for more information.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 68

Setting up the database “Setting up the database” on page 66

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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Connecting to the inventory management database

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX, Heraeus Cytomat PLC, or Agilent Technologies Plate Hub 
Carousel and you are using, or want to set up, inventory management with a 
database. 

Setting up the database 

Before you can connect to the database, you must install and configure the 
inventory management database. To set up the inventory management 
database, contact Automation Solutions Technical Support for assistance.

Connecting to the database

The database connection is specified in VWorks software.

To connect to the database:

1 Navigate to Tools > Options.

2 Under DB Setup, make sure:

• Enable database connection is selected

• Connection string is dsn=velocity11;

Note: This is the standard name for the database but it can be any 
name you would like.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 68

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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Opening the inventory editor

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX, Heraeus Cytomat PLC, or a Agilent Technologies Plate Hub 
Carousel and you are using inventory management with a database.

Before you start

Before you can open the inventory editor, the inventory database that the 
editor communicates with must be installed and configured. 

Opening the inventory editor

To open the inventory editor:

Select Tools > Inventory Editor

You can also open it by selecting a Load or Unload task in a protocol and 
clicking Edit location groups or Edit plate groups.

Closing the inventory editor

To close the inventory editor:

Click the close box in the top right corner.

Related information

For information about... See...

Setting up the inventory 
management database

“Setting up the database” on page 66

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 68

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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About inventory groups

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Inventory groups defined

An inventory group is a group of plates or slots that is a subset of the labware 
listed in the inventory. 

Types of inventory groups

There are two types of inventory groups:

• Location group

• Plate group

Location groups

Location groups are used to move labware to and or from a specific location in 
the storage device.

Example:
In this example, a location group that contains slots 1–10 in cassette 1 is 
created. 

When an Unload task uses this location group, the robot moves whatever 
labware are in cassette 1, slots 1–10, regardless of the identity of the labware, 
out of the storage device and into the system. 

When a Load task uses a location group, it moves the labware that are in the 
system into to cassette 1, slots 1–10 of the storage device, regardless of the 
identity of the labware.

When to use
Location plate groups are used:

• When the storage device is being filled or emptied.

• When groups of plates or labware are removed from the lab automation 
system and replaced with other groups of plates or labware on a regular 
basis. This would be done by replacing a cassette of plates with a new one.

Plate groups

Plate groups are used to move specific plates to or from the storage device, 
but without regard for the location. Plate groups can be used when operators 
do not routinely remove and replace whole cassettes of plates.

When a plate is first moved into the system by the system’s robot, such as 
when it is downstacked, it is assigned an identifier in the database. After that, 
VWorks software tracks where that plate is at all times. This tracking does not 
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require the plates to have barcode labels, VWorks software knows what it does 
with every plate during a protocol and so is able to track where each plate 
goes. Plate groups make use of this tracking system. 

Note: You cannot use a plate group with a Load task, unless a native location 
or location group is associated with it— you have to specify a location group. 
You can, though, associate a plate group with the location group so that the 
plates that are loaded are immediately loaded into a plate group as well.

Note: When you load into a plate group you must also load into a location 
group, native location, or choose return to original locations, otherwise the 
software will not know where to put the plates.

Example:
A plate group in a storage device contains the following plates:

• Plate 26

• Plate 31

• Plate 41

• Plate 107

These plates are scattered around the storage device, not necessarily in 
adjacent slots of the same cassette. When the Unload task uses this plate 
group, it moves these plates out of the storage device into the system.

When to use
Plate groups are typically used in compound management systems where plates 
are housed in the storage device almost permanently. 

For each protocol, a different plate group is unloaded, run and then loaded 
back to a storage device. As long as the identification of the plates are tracked, 
the plates can be stored in any open location.

Group membership

A single plate can be a member of more than one plate group.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 70

Creating a plate group “Creating and managing plate groups” 
on page 72

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83
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Creating and managing location groups

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

To create a location group:

1 Select Inventory Editor from the Tools menu.

2 Click the Location Groups tab.

3 Click Create new and enter a name for the group.

4 Click OK.

5 Select a group of slots in the Available Slots area.

You can use CTRL + click or SHIFT + click to select more than one slot.

6 Drag the group into the Location Members area.

Note: The slots do not have to be adjacent to each other.

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88

For information about... See...
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7 Click Save Changes.

8 Close the inventory editor.

The location group is listed in the Available locations area of the Load/
Unload Task Parameters toolbar.

Deleting a location group

To delete a location group from the inventory:

1 Open the inventory editor.

2 Select a location group in the Saved Locations group box.

3 Click Delete.

Related information

For information about... See...

Creating a plate group “Creating and managing plate groups” 
on page 72

Opening the inventory editor “Opening the inventory editor” on 
page 67

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83
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Creating and managing plate groups

About this topic

This topic describes how to create a plate group, which is a list of specific 
plates that can be moved to or out of a plate storage device without regard for 
which slots they are stored.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

To create a plate group:

1 Select Inventory Editor from the Tools menu.

2 Click the Plate Groups tab.

3 Click Create new and enter a name for the group.

4 Click OK.

To add plates to the plate group:

1 Select a group of available plates.

You can use CTRL + click or SHIFT + click to select more than one plate.

2 Drag the group into the Group Members area.

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88

For information about... See...
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3 Click Save Changes.

4 Close the inventory editor.

The plate group is listed in the Available groups area of the Groups tab in 
the Load/Unload Task Parameters toolbar.

Changing the processing order

You can change the order in which the plates in a plate group will be 
processed.

To change the processing order:

1 In the plate group list, select a plate.

2 Drag it to another position in the list.

Deleting a plate group

To delete a plate group from the inventory:

1 Open the inventory editor.

2 Select the plate group in the Saved Groups group box.

3 Click Delete.
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Related information

Loading labware into storage devices

About this topic

This topic describes how to add plates into the system for storage in a storage 
device. You would do this when first filling the device. Adding plates into the 
system means more than just loading them into a storage device. It means 
adding the plate identifications into the record that VWorks software keeps of 
plates in the system.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Ways to fill a storage device

There are two ways to fill an empty storage device with plates.

• Robotically

• Manually

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 70

Opening the inventory editor “Opening the inventory editor” on 
page 67

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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Loading plates robotically 

To load plates robotically, the plates are placed in a stacker, downstacked and 
moved to the storage device.

To load plates robotically:

1 Create a protocol like the one in the following screenshot:

2 Make sure that the Downstack task is configured to use the stacker.

3 Create a location group.

Make sure that the location group is listed in the Available locations area 
of the Load Task Parameters toolbar.

4 Drag the group into the Assigned locations area.

5 Click Start and resolve any error messages.

Note: If you are using the simulator to “virtually” load plates, make sure 
that simulation mode is on before you click Start.
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6 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of plates you want to load into the storage device.

7 Click OK.

8 Confirm that the plates are in the inventory:

a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

Loading plates manually

Plates can be loaded manually two ways:

• Cassettes of plates are physically put in to the storage device and a run is 
simulated to create the matching list of plates in the inventory

• Cassettes of plates are physically put into the storage device, manually 
added to the inventory and then re- inventoried 

Note: To load by reinventory, the storage device must have a barcode 
reader.

To load plates manually using a simulated run:

1 Physically load the cassettes of plates in to the storage device.

2 Follow the procedure for loading plates robotically, but click Simulation is off 
to turn on the simulator.

Make sure that the location group matches the cassettes that you loaded.

3 Click Start to run the simulator.

4 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of plates you want to load into the storage device.

5 Review the inventory editor to make sure that the plates listed in the 
inventory match the plates actually in the device.

6 Click Simulation is on to turn off the simulator.

To load plates manually and then re-inventory:

1 Physically load the cassettes of plates in to the storage device.

2 Open the Inventory Editor and click the Inventory Management tab.

3 From the Select view type list, select View by location (shows all available plate 
locations whether they are occupied or not.

4 In the Inventory Management Functions area:

a Enter the name of the plates in the Name field.

b Select the labware type from the Labware list.
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c Select Replace inventoried labware with the labware type selected above ONLY if a 
labware type is not already assigned. (This prevents you from accidently 
overwriting an occupied slot with the wrong labware type).

5 Select the slots you loaded the plates into. Use SHIFT- click or CTRL + click 
to select more than one item.

6 Click Re-inventory selected locations.

Related information

For information about... See...

Moving plates out of a storage 
device

“Unloading labware out of inventory” 
on page 81

Moving plates between storage 
devices

“Moving labware between storage 
devices” on page 78
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Moving labware between storage devices

About this topic

This topic provides an example to illustrate how you can move a group of 
plates out of one storage device and put them into another. The general 
procedure could also be used to move a group of plates within a single storage 
device.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Before you start

Make sure that both plate storage devices are properly configured in the device 
manager.

Moving a plate

In this example procedure, a group of four plates is moved from one plate 
storage device (PlateHub) to another (PlateHub2).

To move a plate:

1 Create a process that has a Load and an Unload task, as shown in the 
following example.

2 Select either the Load or Unload task and click Edit location groups.

The inventory editor opens.

3 Click the Inventory Management tab and note the device, cassette, and slot 
locations of the plates that you want to move.

In this example, the plates will be moved from PlateHub, cassette 1, 
slots 1–4.

4 Click the Location Groups tab and create a location group for these plates.

Note: The plates do not need to be in adjacent slots for them to be in a 
location group.
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5 Return to the Inventory Management tab and note the device, cassette and 
slot numbers for the slots that you want to move the plates to. 

In this example, the plates will be moved to PlateHub2, cassette 12,  
slots  7- 10.

6 Click the Location Groups tab and create a location group for these slots.

7 Click Save changes and close the inventory editor.

8 Select the Unload task and in the Task Parameters toolbar drag the location 
group in the first device to the Assigned locations area.

9 Select the Load task and in the Protocol Task Parameters toolbar drag the 
location group in the second device to the Assigned locations area.
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10 Compile the protocol and check for errors.

11 Click Start to start the run.

12 In the Number of Cycles dialog box, type in the number of plates that you are 
moving and click OK.

13 Open the inventory editor and click the Inventory Management tab to make 
sure that the plates moved as expected.

Related information

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 70

Creating a plate group “Creating and managing plate groups” 
on page 72

Opening the inventory editor “Opening the inventory editor” on 
page 67

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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Unloading labware out of inventory

About this topic

This topic describes how to remove plates that are in a storage device from the 
system. Removing plates from the system is more than just unloading them 
from the storage device. It means removing the plates from the lab automation 
system as well as removing the plate identifications from the record of the 
plates in the system that VWorks software keeps.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Ways to unload plates

There are two ways to remove plates from a plate storage device.

• Robotically

• Manually

Unloading plates robotically

To unload plates from a storage device robotically:

1 Create a protocol like the one shown in the following screenshot:

2 Make sure that the Upstack task is configured to use the appropriate 
stacker.

3 In the inventory editor, identify the plates that you want to move:

a Click the Unload task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab. Note the device, cassette and slot 
numbers for the plates that you want to remove.

4 If necessary, create a location group in the inventory editor that contains 
the plates you want to remove. 

Save the changes and confirm it by making sure it is listed in the Available 
locations area on the Locations tab of the Load Task Parameters toolbar.
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5 Drag the location group into the Assigned locations area.

6 Click Start.

7 In the Number of Cycles dialog box, enter a number that equals the number 
of plates you want to remove from the storage device.

8 Click OK.

9 Confirm that the plates are no longer in the inventory:

a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

Unloading a storage device manually

To unload a storage device manually, cassettes of plates are physically removed 
from the storage device and a run is simulated to unload the matching list of 
plates from the inventory. 

To unload plates manually using a simulated run:

1 Physically remove the cassettes of plates from the storage device.

2 Follow step 1 to step 5 in the procedure above for unloading a storage 
device robotically.

3 Click Simulation is off to turn on the simulator.

4 Click Start.

5 In the Number of Cycles dialog box, enter a number that equals the number 
of plates you want to remove from the storage device.

6 Click OK.

7 Confirm that the plates are no longer in the inventory:

a Click the Load task.

b Click Edit location groups to open the inventory editor.

c Click the Inventory Management tab.

To unload plates manually and then reinventory the database:

1 Physically unload the cassettes of plates from the storage device.
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2 Open the Inventory Editor and click the Inventory Management tab.

3 From the Select view type list, select View by location (shows all available plate 
locations whether they are occupied or not.

4 Select the slots you unloaded the plates from. Use SHIFT- click or CTRL + 
click to select more than one slot.

5 In the Inventory Management Functions area, click Delete selected entries from 
inventory. Click Yes to the message asking if you are sure you want to delete 
the selected plates (they will be permanently deleted from the database).

6 Click Re-inventory selected locations.

Related information

Using a plate group to process plates

About this topic

This topic shows an example protocol where a plate group is moved out of a 
Plate Hub Carousel, transferred to a liquid- handling device where liquid is 
aspirated, and then loaded back into the same or different locations of the 
Plate Hub Carousel.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, Agilent Technologies Plate 
Hub Carousel.

For information about... See...

Creating a location group “Creating and managing location 
groups” on page 70

Creating a plate group “Creating and managing plate groups” 
on page 72

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Moving labware between storage 
devices” on page 78

Incubating plates “Using a plate group to process plates” 
on page 83

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88
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Before you start

• Place plates in a Plate Hub Carousel (or other) storage device and make 
sure they are stored in the inventory editor

• Create a plate group containing the plates you want processed

• Select the Dynamically assign empty slot to load to storage device option, 
located under Protocol Options, to enable the software to track individual 
plates

Processing a plate group and returning the plates to the original location

To process a plate group:

1 Create a process like the one shown below.

2 Select the Unload task and in the Task Parameters toolbar, click the Groups 
tab and drag the plate group to the Assigned location area.

3 Select Remove plates from group when processed if you want them to be handled 
in the same numerical order and/or will not be reusing the plates. 

Note: The plates can be loaded back into the group during the load task 
execution.

4 Select the Load task and then select Use original locations. The Locations and 
Native tabs will become uneditable.
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Optional. You can reassign the plates back to the original group or to a 
new plate group. Click the Groups tab and drag the plate group from the 
Available groups area to the Assigned locations area. 

5 Click Start.

6 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of plates you want to process from the group.

7 Click OK.

8 Confirm that the plates have been returned to their original position in the 
inventory:

a Click the Load task.

b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.

Processing a plate group and returning the plates to a different location

To process a plate group:

1 Create a protocol like the one shown below.
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2 Select the Unload task and in the Task Parameters toolbar, click the Groups 
tab and drag the plate group you created at the beginning to the Assigned 
locations area.

3 Select the Load task and in the Task Parameters toolbar choose one of the 
following ways to load the plates into a different location.

• Specify a pre- defined location group to load to. To specify a pre-
defined location group, click the Locations tab and drag the location 
group in the Available locations to the Assigned locations area.

• Assign specific locations to load to without using a location group. To 
assign specific locations without defining a location group, click the 
Native tab and drag the locations from the Available locations area to the 
Assigned locations area.
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4 Click Start.

5 In the Number of Cycles dialog box, enter a number that is equal to or less 
than the number of plates you want to process from the group.

6 Click OK.

7 Confirm that the plates have been returned to their assigned positions in 
the inventory:

a Click the Load task.

b Click Edit location groups or Edit plate groups.

c Click the Inventory Management tab.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 62

Creating a plate group “Creating and managing plate groups” 
on page 72

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Using barcode input files “Creating a plate group with a barcode 
input file” on page 88

Starting a run VWorks Automation Control User 
Guide



4   Tracking and managing labware in storage
Creating a plate group with a barcode input file

88 VWorks Automation Control Setup Guide

Creating a plate group with a barcode input file

About this topic

This topic describes how to use a barcode input file to create a plate group. 
This is the most efficient way to create plate group if you previously used a 
barcode input file to label a collection of plates. which are now stored in a 
storage device.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Procedure

IMPORTANT All plates with barcodes listed in the selected barcode input file 
series must already be in the storage device.

To create a plate group with a barcode input file:

1 Open the inventory editor.

2 Click the Groups tab.

3 Click the Browse button and navigate to the .bar file that you want to use.

4 From the Available Barcode groups list box, select the group that you want to 
use.

In the following example of a barcode input file, the options would be Set1 
and Set2.
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5 Click Import.

The plates labelled with west- side barcodes listed in the series will be used 
to create a group and will appear in the Plates currently in the selected group 
list.

6 Specify a labware type for each plate using the labware selection function 
in the Inventory Management tab.

Related information

For information about... See...

Software inventory “About labware inventory management” 
on page 62

Opening the inventory editor “Opening the inventory editor” on 
page 67

Using the labware selection list “Reinventorying the plate inventory” on 
page 94
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Inventory editor views and filters

About this topic

This topic describes how to make the inventory editor easier to work with by 
showing only the items in the inventory editor that are relevant at the 
particular time.

Who should read this

Read this topic if your lab automation system has a storage device such as a 
Liconic StoreX incubator, Heraeus Cytomat PLC, or Agilent Technologies Plate 
Hub Carousel.

Inventory editor views

There are three ways to view the plates in the inventory editor.

To set the view:

1 Open the inventory editor.

2 Click to select the Inventory Management tab.

3 From the Select view type list, select one of the following options:

Filtering displayed plates

You may have many plates stored in the database. To simplify your view of the 
database, you can filter the records that are displayed.

To filter the plate records:

1 Right- click on a list in any of the tabbed pages of the inventory editor and 
select Show all.

2 Right- click on a particular cell and select from the available filtering 
options.

View Description

View by plate Displays every plate in the inventory. 

This is the most frequently used view.

View by location Displays both plates and slots.

View unassigned plates Displays plates that were orphaned 
during previous runs. This means 
plates that are in the system but not 
in a storage device.

View Description

Use last filter Returns the display of items to that 
displayed when the last filter was 
applied
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The items that have the same value as the selected item in the row are 
displayed.

The result is that only those plates in cassette number 2 are listed.

To show all plate records:

Right- click on the database list and select Show all.

Related information

Filter by row The items that have the same value 
as the selected item in the row are 
displayed

Filter by column The items that have the same value 
as the selected item in the column 
are displayed

View Description

For information about... See...

Software inventory “About labware inventory management” 
on page 62

Opening the inventory editor “Opening the inventory editor” on 
page 67
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Auditing plate volumes in the inventory editor

About this topic

Sometimes it is useful to view the results of pipetting tasks visually. VWorks 
software does this by tracking the pipetting tasks performed on a plate during 
a protocol run, calculating the volume resulting from those tasks, and storing 
the information in the database. When the plate is viewed in the software, the 
volume is represented with color.

This topic describes how to audit a plate’s volume using the inventory editor.

Procedure

To audit the volume of a plate:

1 Open the inventory editor.

2 Click the Inventory Management tab.

3 From the Select view type list, select the view.

4 Select the plate you want to audit.

5 Click Visualize Plate. The Audit Plate dialog box opens.
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The volume of liquid is visualized by a color gradient, displayed on the 
right. The limits of this gradient is controlled by the buttons in the Scaling 
area. 

The color legend indicates what the well color will be for the following 
conditions.

Click this button... To...

Zero based plate limits Set the gradient limits from zero to 
the highest volume found on the 
plate

Auto scale to plate limits Set the gradient limits to the 
lowest and highest volume found 
on the plate.

Fixed Scales 1- 7 µL Set the min and max limits to 1  
and 7 µL respectively.

Manual limits (thresholds) Manually set the lower and upper 
limits. Enter the value (in µL) in 
the Min and Max fields.
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Double- click on a color in the legend to change it.

Related topics

Reinventorying the plate inventory

About this topic

This topic describes how to use the reinventory feature of plate inventory.

This feature can be used to check for mismatches by comparing the identities 
of the plates actually in a plate storage device with the plates that the 
inventory database says should be in the plate storage device. 

Mismatches can arise, for example, if you physically load plates into the 
storage device and then use the simulator to virtually “move the plates” into 
the database without specifying a plate type before running the simulated 
protocol. In this case there will be no labware associated with the plates.

The reinventory feature can also be used to enter barcode information for 
plates that have been manually placed into the storage device.

Note: Reinventorying requires that the storage device have a barcode reader.

Who should read this

Read this topic if your lab automation system has a plate storage device that 
includes an optional barcode reader.

Condition Description

Not surveyed The well is not available for 
measurement.

Empty The well is empty.

Below threshold The well is below the lower limit set 
by the user.

Above threshold The well is above the upper limit set 
by the user.

For information about... See...

Software inventory “About labware inventory management” 
on page 62

Opening the inventory editor “Opening the inventory editor” on 
page 67
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About performing an inventory

The accuracy of the inventory database can be checked by performing a new 
inventory of the database. You can perform an inventory of the entire storage 
device or part of it.

The device’s barcode reader checks all selected slots for the presence of a 
barcode and reads those that it finds. The results are checked against the 
inventory database.

IMPORTANT For reinventorying to be successful, each plate must have a 
unique barcode.

Reinventorying logic

If a plate is found in a slot that, according to the inventory database, should 
not have a plate, a line is added to the inventory editor for that slot and the 
plate’s barcode is recorded. If that barcode is already associated with another 
slot in the database, the previous association is deleted. In doing this, the 
system assumes that the plate has been manually moved.

If the inventory has a line for a plate in a particular slot, but the inventory 
finds no plate in that slot, the line is removed from the inventory. However, 
the data in the system that is associated with the plate is not deleted. If in the 
future, a plate with an identical barcode is returned to the system, when the 
next inventory is performed the data can be reassociated with it.

Procedure

To reinventory the plate storage device:

1 Open the inventory editor.

2 Click the Inventory Management tab.

3 From the Select view type list box, select View by location.

This lists the plates in the inventory database by location.

4 Select the plates that you want to inventory.

You can use SHIFT + click to select a range of listed plates.

5 In the Name text box, type the name of the location group.

6 From the Labware list box, select the type of labware to associate.

7 Select one of the following options:

Option Comments

Replace any inventoried labware 
with the labware selected above

Labware for all selected items are 
replaced with the labware displayed 
in the list box. This overwrites 
labware already assigned.
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8 Click Reinventory selected locations.

A barcode reader reads each plate in the storage device and adds the 
barcode data to the inventory database.

Related information

Replace inventoried labware 
with the labware selected above 
ONLY if a labware is not already 
assigned

Labware for all selected items that do 
not already have a labware entry are 
replaced with the indicated labware.

Option Comments

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 68

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the plate inventory” on 
page 94

Inventory editor filters “Inventory editor views and filters” on 
page 90
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Resolving plate inventory problems

About this topic

This topic describes how to check and test the Windows Open Database 
connection that is used by the VWorks software inventory management system. 

Checking the database settings

The inventory management database uses a Windows Open Database 
Connectivity (ODBC) interface. If you encounter inventory management 
problems, you may need to check the database settings.

To check the database settings:

1 In Windows, navigate to Start > Settings > Control Panel > Administrative Tools > 
Data Sources (ODBC).

The ODBC Data Sources Administrator dialog box opens.

2 Click the System DSN tab.

3 Click Configure.

The Connector/ODBC dialog box opens showing the database settings.
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The Data Source Name and Database Name fields must both contain 
“velocity11”.

Testing the connection

To test the database connection:

1 Follow the procedure in “Checking the database settings” on page 97 to 
open the Connector/ODBC dialog box.

2 Click Test.

A dialog box like the following example confirms a successful connection.

Related information

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 68

Moving plates in and out of a 
storage device

• “Loading labware into storage 
devices” on page 74

• “Unloading labware out of 
inventory” on page 81

• “Moving labware between storage 
devices” on page 78

Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the plate inventory” on 
page 94
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Inventory editor filters “Inventory editor views and filters” on 
page 90

For information about... See...
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5
Managing user accounts

This chapter contains the following topics:

• “Planning user accounts and privileges” on page 102

• “Managing user accounts” on page 103

• “Setting up email for error notification” on page 105
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Planning user accounts and privileges

The role of user accounts

You must have a user account to log in to VWorks software. Your user account 
is associated with a user role that determines the privileges you have to 
perform particular functions. Users are added and assigned privileges by an 
Administrator.

The effect of privileges

Privileges have the following effects:

• If you do not have the privilege to perform a function associated with a 
particular menu command, the text of the command is gray.

• If you do not have the privilege to perform the functions accessed from a 
particular tabbed page, the tab is not visible to you.

• In some cases, if you do not have the privilege to perform an operation, 
when you attempt the operation you get an error message telling you that 
your privileges are insufficient.

User roles and privileges

User roles enforce the following privileges:

 

User role Has privileges to...

Guest • Log in and log out.

• Access Knowledge Base through the Help menu.

• Use context- sensitive help.

Operator • Perform guest functions (see above).

• Operate devices in real- time using diagnostics 
software.

• Run protocols.

Technician • Perform operator functions (see above).

• Create and save protocols.

• Manage devices through the device manager.

• Perform all of the functions listed in the Tools 
menu (except managing users).

Administrator • Perform technician functions (see above).

• Manage user accounts.

• Run a protocol that contains compiler errors.
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Related information

Managing user accounts

About user accounts and passwords

User accounts and passwords use the following conventions:

• User accounts can be disabled but not deleted.

• User names and passwords are case- sensitive.

• Passwords must contain six or more characters.

• If a user enters an incorrect password five times consecutively, the user is 
locked out until an administrator resets the account.

Adding a user account

To add a user account:

1 Select Tools > User Management.

2 In the User Management dialog box, click Create new user and enter a name 
for the user.

3 In the Set Password dialog box, enter the password twice for the new user.

4 Enter values in the User information, and User security areas.

5 Click Update selected user to save changes, and then close the dialog box.

For information about... See...

managing user accounts “Managing user accounts” on page 103

Setting up email notification “Setting up email for error notification” 
on page 105
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Disabling a user account

You cannot delete a user account, but you can disable it.

To disable an account so that the user cannot log in:

1 Select Tools > User Management.

2 Select the account.

3 Select the Account disabled check box.

4 Click Update selected user to save changes, and then close the dialog box.

Resetting a user account

If a user mistypes the password five consecutive times, the user is locked out 
of the account until an administrator resets the account.

To reset an account:

1 Select Tools > User Management.

2 Select the account.

3 Click Reset failed login count.

4 Click Update selected user to save changes, and then close the dialog box.

Changing a password

An administrator can reset the password of any account. Technicians can 
change their own passwords at Log in.

To reset a password:

1 Select Tools > User Management.

2 Select the account.

3 Click Set password, enter the new password twice and click OK.

4 Click OK to the Password Update message.

Related information

For information about... See...

User accounts “Planning user accounts and privileges” 
on page 102

Setting up email notification “Setting up email for error notification” 
on page 105
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Setting up email for error notification

About email error notification

Email setup in VWorks software enables you to do the following tasks:

• Automatically be notified by email or pager when errors occur during a 
protocol run

• Send a bug report to Agilent Technologies

Requirements for email notification

Before you can send an email from VWorks software, the controlling computer 
must:

• Be connected to a network with internet access

• Have network access to an outgoing mail server that supports one of the 
authentication methods available through VWorks software.

Procedure

To set up the outgoing mail server:

1 Select Tools > Options.

2 In the Email Setup area make sure Enable email notification is selected.

3 Enter the name of your SMTP server name (outgoing email server).

4 If the server requires a user name and password:

a Select the Authentication type from the list.

IMPORTANT The authentication type is critical. Check with your 
network administrator to determine the best authentication network 
for your email server. (NTLM is typically used when Microsoft 
Exchange is the email server.)

b Enter your Authenticated user name and Password for the selected 
authentication type.

5 Next to the Send email from field, enter the email address you want to use 
for auto- generated crash reports.

6 Select Send email when an error occurs, then next to Addresses to send to when an 
error occurs, enter the address to which you want the email delivered. 

Note: Multiple email addresses must be separated with a semicolon.

7 Click OK to save the email setup information and close the dialog box.
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Related information

For information about... See...

Using user accounts “Planning user accounts and privileges” 
on page 102

Managing user accounts “Managing user accounts” on page 103
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6
VWorks ActiveX control

This chapter contains the following topics:

• “About the VWorks ActiveX control” on page 108

• “Methods” on page 110

• “Events” on page 122

• “Enumerated types” on page 125
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About the VWorks ActiveX control 

What is the VWorks ActiveX control

The VWorks ActiveX control is the software component that allows the VWorks 
software to interact with a third- party lab automation system.

How the VWorks ActiveX control is used

In an Agilent Technologies automation system, VWorks software is already 
configured to interface with the VWorks software. The operator can control the 
device using the software.

In a third- party lab automation system, you need to use ActiveX to enable the 
third- party software to interface with the VWorks software. Each ActiveX 
control consists of a collection of the following:

• Methods. Functions that can be called to invoke individual operations

• Properties. Variables that are used in methods (for example, speed = fast)

• Events. Notifications that methods have completed or resulted in errors

When integrating the VWorks software in a lab automation system, you need to 
know the available methods and properties for the ActiveX control.

The following diagram illustrates the use of the VWorks ActiveX control in a 
lab automation system environment. Actions you perform are conducted 
through ActiveX methods. System responses are relayed back through ActiveX 
events.

Integrating the VWorks ActiveX control

When integrating the VWorks ActiveX control in a third-party lab software:

1 Install the VWorks ActiveX control. To install the VWorks ActiveX control:

Computer

Third-party 
software

VWorks

ActiveX

Methods Events
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a Insert the VWorks software CD into the controlling computer CD- ROM 
drive.

b In the CD folder, double- click VWorks Installer.exe.

c Follow the directions in the installation wizard window.

2 Open the Command Prompt window and type VWorks/register to register 
the application program interface.

3 Refer to the description of the Methods and Properties in this section.
 

Related information

For information about... See...

VWorks ActiveX methods “Methods” on page 110

VWorks ActiveX events “Events” on page 122

VWorks ActiveX enumerated types “Enumerated types” on page 125
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Methods

AbortProtocol

Description
Aborts the protocol run that is in progress.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorks4COM.AbortProtocol();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorks4COM.AbortProtocol()

CloseProtocol

Description
Closes the specified protocol file.

Parameters

Returns

Name Type Description

returnCode V11ReturnCode See“Enumerated types” 
on page 125.

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Note: returnCode is 
RETURN_SUCCESS if the file 
closed successfully.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.CloseProtocol(“myprotocol.pro”);

Visual Basic .NET example
Dim vwRetCode As VWorks4Lib.V11ReturnCode

vwRetCode = oVWorksCOM.CloseProtocol(“myprotocol.pro”)

CompileProtocol

Description
Compiles the protocol and is used with the LogMessage event.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

LONG errCount, wrnCount;

retCode = oVWorks4COM.CompileProtocol (“c:\\myprotocol.pro”, 
&errCount, &wrnCount);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

Dim errCount, wrnCount as Long

retCode = oVWorks4COM.CompileProtocol (“c:\myprotocol.pro”, 
errCount, wrnCount)

EnumerateUsers

Description
Returns the list of users with VWorks accounts.

Parameters
None.

Name Type Description

protocol BSTR The protocol file path.

errorCount *LONG The number of errors found.

warningCount *LONG The number of warnings found.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Returns

Visual Basic .NET example
Dim oEnumerateUsers As Object = Nothing

Dim retCode As VWorks4Lib.V11ReturnCode

Dim sUsers As String = ""

retCode = oVWorksCOM.EnumerateUsers(oEnumerateUsers)

If Not (oEnumerateUsers Is Nothing) Then

Dim i As Integer

For i = 0 To oEnumerateUsers.GetLength(0) - 1

sUsers = sUsers & oEnumerateUsers(i) & " , "

Next

End If

GetSimulationMode

Description
Gets the simulation mode state.

Parameters
None.

Returns

Name Type Description

user *VARIANT The user name.

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

mode VARIANT_BOOL The value that indicates the 
simulation state:

• True = The simulation 
mode is on.

• False = The simulation 
mode is off.
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Visual C++ example
VARIANT_BOOL bSimMode;

bSimMode= oVWorksCOM.GetSimulationMode();

Visual Basic .NET example
Dim bSimMode as Boolean

bSimMode= oVWorksCOM.GetSimulationMode()

GetTipStates

Description
Gets the state of the tipboxes in a protocol for automated tip tracking.

Parameters

Returns

Visual Basic .NET example
Dim TipStateXML As String = ""

Dim retCode As VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.GetTipStates(“c:\myprotocol.pro”, 
TipStateXML)

LoadProtocol

Description
Loads the protocol for a run.

Parameters

Returns

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

TipStateXML BSTR The current status of the 
tipboxes.

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.CompileProtocol(“c:\\myprotocol.pro”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.CompileProtocol (“c:\myprotocol.pro”)

LoadRunsetFile

Description
Loads the runset file.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.LoadRunsetFile (“c:\\myrunset.rst”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.LoadRunsetFile (“c:\myrunset.rst”)

Login

Description
Logs into VWorks software using the provided user name and password.

Parameters

Name Type Description

runset BSTR The runset file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

userName BSTR The user name.

password BSTR The password.
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Returns

Visual C++ example
VWorks4Lib.V11LoginResult retCode;

loginResult= oVWorksCOM.Login(“user1”,“mypassword!”);

Visual Basic .NET example
Dim loginResult as VWorks4Lib.V11LoginResult

loginResult= oVWorksCOM.Login(“user1”,“mypassword!”)

Logout

Description
Logs out the current user session.

Parameters
None.

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.Logout();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.Logout()

PauseProtocol

Description
Pauses the protocol run that is in progress. The tasks that are in progress will 
be finished. No new tasks will be started.

Parameters
None.

Returns

Name Type Description

loginResult V11LoginResult See “Enumerated types” on 
page 125.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.PauseProtocol();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.PauseProtocol()

ReinitializeDevices

Description
Reinitializes devices.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ReinitializeDevices ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ReinitializeDevices ()

ResumeProtocol

Description
Resumes the protocol run.

Parameters
None.

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode = oVWorksCOM.ResumeProtocol ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode = oVWorksCOM.ResumeProtocol ()

RunProtocol

Description
Starts the protocol run.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.RunProtocol (“c:\\myprotocol.pro”,2);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM.RunProtocol (“c:\myprotocol.pro”,2)

SetSimulationMode

Description
Sets the simulation mode.

Parameters

Name Type Description

protocol BSTR The protocol file path.

runCount LONG The number of times to run 
the protocol.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

mode VARIANT_BOOL The value that sets the 
simulation state:

• True = Turns on the 
simulation mode.

• False = Turns off the 
simulation mode.
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Returns

Visual C++ example
oVWorksCOM.SetSimulationMode(VARIANT_TRUE);

oVWorksCOM.SetSimulationMode(VARIANT_FALSE);

Visual Basic .NET example
oVWorksCOM.SetSimulationMode(True)

oVWorksCOM.SetSimulationMode(False)

ShowDiagsDialog

Description
Displays the device diagnostics dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowDiagsDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowDiagsDialog ()

ShowLoginDialog

Description
Displays the User Authentication (or login) dialog box.

Parameters
None

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Note: returnCode is always 
RETURN_SUCCESS.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.



119

6   VWorks ActiveX control
Methods

VWorks Automation Control Setup Guide

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowLoginDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowLoginDialog ()

ShowManageUserDialog

Description
Displays the User Management dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowManageUserDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowManageUserDialog ()

ShowOptionsDialog

Description
Displays the Options dialog box.

Parameters
None

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowOptionsDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowOptionsDialog ()

ShowPlateGroupEditorDialog

Description
Displays the Plate Group Editor dialog box.

Parameters
None

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowPlateGroupEditorDialog ();

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowPlateGroupEditorDialog ()

ShowTipStateEditor

Description
Displays the Tip State Editor dialog box.

Parameters

Returns

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

Name Type Description

Protocol BSTR The protocol file path.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.
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Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowTipStateEditor 
(“c:\\myprotocol.pro”);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowTipStateEditor 
(“c:\myprotocol.pro”)

ShowVWorks

Description
Displays or hides the VWorks software window.

Parameters

Returns

Visual C++ example
VWorks4Lib.V11ReturnCode retCode;

retCode=oVWorks4COM.ShowVWorks (VARIANT_TRUE);

Visual Basic .NET example
Dim retCode as VWorks4Lib.V11ReturnCode

retCode=oVWorks4COM. ShowVWorks (True)

Related information

Name Type Description

showOrHide VARIANT_BOOL The value that displays or 
hides the window:

• TRUE = Display the 
window.

• FALSE = Hide the window.

Name Type Description

returnCode V11ReturnCode See “Enumerated types” on 
page 125.

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 108

VWorks ActiveX events “Events” on page 122

VWorks ActiveX enumerated types “Enumerated types” on page 125



6   VWorks ActiveX control
Events

122 VWorks Automation Control Setup Guide

Events

LogMessage

Description
The LogMessage event occurs every time a message is posted to the log.

Parameters

Returns
None.

PromptUser

Description
The PromptUser event occurs every time VWorks software displays a message 
that expects the operator to respond with a decision.

Parameters

Name Type Description

session LONG The session ID.

logClass LONG The type of log event: Error, 
Warning, or Event.

timeStamp BSTR The time at which the error 
occurred.

device BSTR The device name. An empty 
string is permitted.

location BSTR The location. An empty string 
is permitted.

process BSTR The process plate name. An 
empty string is permitted.

task BSTR The task name. An empty 
string is permitted.

fileName BSTR The protocol file or device file 
name. An empty string is 
permitted.

message BSTR The the error message text.

Name Type Description

session LONG Session ID

prompt BSTR Message to prompt
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Returns

ProtocolComplete

Description
The ProtocolComplete event occurs after startup, cleanup, and main protocols 
are finished.

Paramters

Returns
None.

ProtocolAborted

Description
The ProtocolAborted event occurs when the operator or automation client 
aborts the protocol run.

Parameters

Returns
None.

RecoverableError

Description
The RecoverableError event occurs whenever an error is displayed and expects 
the operator to abort, retry, or ignore the error.

Name Type Description

choice *LONG 0 = OK, 1 = Cancel

Name Type Description

session LONG The session ID.

protocol BSTR The protocol file path.

protocol_type BSTR The type of protocol: Startup, 
Main, or Cleanup.

Name Type Description

session LONG The session ID.

protocol BSTR The protocol file path.

protocol_type BSTR The type of protocol: Startup, 
Main, or Cleanup.
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Parameters

Returns

UnrecoverableError

Description
The UnrecoverableError event occurs when an error is displayed and does not 
expect the operator to respond with a decision.

Parameters

Returns
None.

Name Type Description

session LONG The session ID.

device BSTR The device name. An empty 
string is permitted.

location BSTR The location. An empty string is 
permitted.

description BSTR The description of the error.

Name Type Description

actionToTake *LONG The value that indicates the 
action to take:

• 0 = Abort

• 1 = Retry

• 2 = Ignore

vworksHandlesError *VARIANT_BOOL Value values are:

• TRUE = Allows the VWorks4 
software to handle the error. 
the VWorks4 software will not 
display the error message.

• FALSE = Prevents the 
VWorks4 software from 
handling the error.

Name Type Description

session LONG The session ID.

description BSTR The description of the error.
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UserMessage

Description
The UserMessage event occurs when a User Message task occurs.

Parameters

Returns

Related information

Enumerated types

V11ReturnCode

Description
Indicates the method call status.

Constants

Name Type Description

session LONG User message tasks can 
prompt user for data entry.

caption BSTR

message BSTR

wantsData VARIANT_BOOL

Name Type Description

userData *BSTR Allows user to enter data if 
wantsData = True.

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 108

VWorks ActiveX methods “Methods” on page 110

VWorks ActiveX enumerated types “Enumerated types” on page 125

Name Value Description

RETURN_SUCCESS 0 The method was called 
successfully.

RETURN_BAD_ARGS 1 The method contains bad 
arguments.
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V11LoginResult

Description
Indicates the login status.

Constants

Related information

RETURN_FAIL 2 The method call failed.

Name Value Description

Name Value Description

LOGIN_SUCCESS 0 The login was successful.

LOGIN_FAIL 1 The login failed.

LOGIN_DISABLED 2 The login was disabled.

LOGIN_EXPIRED 3 The login period passed.

LOGIN_TOO_MANY_FAILED
_ATTEMPTS

4 Too many login attempts were 
made and failed.

LOGIN_NOT_ENOUGH_AUT
HORIZATION

5 Higher access priveleges are 
required to perform the 
requested action.

For information about... See...

VWorks ActiveX control “About the VWorks ActiveX control” on 
page 108

VWorks ActiveX methods “Methods” on page 110

VWorks ActiveX events “Events” on page 122
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Glossary

clamps (BenchCel)  The components inside of the 
stacker head that close and open the stacker 
grippers during the loading, unloading, 
downstacking, and upstacking processes.

controlling computer  The lab automation system 
computer that controls the devices in the system.

cycle  See seal cycle.

deadlock  An error that occurs when the number of 
locations available in the system is less than the 
number of microplates in the system. Because the 
microplates cannot move to the expected 
locations, the protocol pauses.

device  An item on your lab automation system that 
can have an entry in the device file. A device can 
be a robot, an instrument, or a location on the lab 
automation system that can hold a piece of 
labware.

device file  A file that contains the configuration 
information for a device. The device file has the 
.dev file name extension and is stored in the 
folder that you specify when saving the file.

downstack  The process in which a microplate is 
moved out of the stack.

error handler  The set of conditions that define a 
specific recovery response to an error.

home position  The position where all robot axes are 
at the 0 position (the robot head is approximately 
at the center of the x- axis and at 0 of the z- axis, 
and the robot arms are perpendicular to the x-
axis). 

homing  The process in which the robot is sent to the 
factory- defined home position for each axis of 
motion.

hot plate (PlateLoc)  A heated metal plate inside the 
sealing chamber that descends and presses the 
seal onto the plate.

insert  A pad placed under the plate to support the 
bottom of the wells for uniform sealing. 

location group  A list of labware that can be moved 
into or out of particular slots in a storage device.

plate group  A list of specific labware that can be 
moved into or out of a storage device without 
regard for the slot locations.

plate instance  A single labware in a labware group 
that is represented by the process plate icon. 

plate stage  The removable metal platform on which 
you load a plate.

plate-stage support  The structure on which you load a 
plate stage. The plate- stage support extends when 
the door opens.

profile  The Microsoft Windows registry entry that 
contains the communication settings required for 
communication between a device and the VWorks 
software.

process  A sequence of tasks that are performed on a 
particular labware or a group of labware.

protocol  A schedule of tasks to be performed by a 
standalone device, or devices in the lab 
automation system.

regripping station  A location that enables the robot to 
adjust its grip at the specified gripping height. 
The location is typically used after a robot picks 
up a labware higher than the specified gripping 
height because the labware was sitting in a box.

robot grippers  The components that the robot uses to 
hold labware.

run  A process in which one or more microplates are 
processed. In a standalone device, the run 
consists of one cycle. In a lab automation system, 
a run can consist of multiple cycles that are 
automated.

safe zone  The boundary within which the robot is 
allowed to move without colliding with external 
devices.

seal cycle  The process in which a single plate is 
sealed on the PlateLoc Sealer.

seal entry slot  The narrow entry on the back of the 
PlateLoc Sealer where the seal is inserted into the 
device.

seal-loading card  A rectangular card that is used to 
facilitate the seal loading process on the PlateLoc 
Sealer.

seal-roll support  The triangular structures at the top 
of the PlateLoc Sealer where a roll of seal is 
mounted.

sealing chamber  The area inside of the PlateLoc 
Sealer where the seal is applied to a plate.
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shelves (BenchCel)  The components inside of the 
stacker head that provide leveling surfaces for the 
microplates, thus ensuring accurate robot 
gripping, during the downstacking process.

stacker grippers  The padding at the bottom of the 
stacker racks that hold microplates when a 
microplate is loaded, downstacked, or upstacked.

subprocess  A sequence of tasks performed as a 
subroutine within a protocol. Typically the 
subprocess is performed by a single device type, 
such as the Bravo device.

task  An operation performed on one or more 
labware.

task parameters  The parameters associated with each 
task in a protocol. For example, in a labeling task, 
the parameters include the label value.

teachpoint  A set of coordinates that define where the 
robot can pick up or place labware and the 
location of a known object.

teachpoint file  The XML file that contains the settings 
for one or more device teachpoints. 

touch screen  The interface on the front of the 
PlateLoc Sealer where sealing parameters are set, 
the seal cycle can be started or stopped, and the 
seal cycle can be monitored.

upstack  The process in which a microplate is moved 
back into the stack.

waypoint  A set of coordinates that define a location 
the robot passes through on its way to a 
teachpoint.

workspace  The boundary within which the robot can 
move without limitations.
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Index
A
acceleration property, 55, 56
ActiveX

described, 108
administrator privilege, 102

B
barcode

inventory manager, 62
tracking, 62

barcode input file
creating plate group, 88

C
can be mounted property, 30
can be sealed? property, 29
can have lid? property, 29
can mount property, 30
cassette, defined, 62
check orientation property, 48
column-wise teachpoint to well property, 32
column-wise well to well property, 32
context-sensitive help, ix
Cytomat, 74

manually loading plates, 76
manually unloading plates, 82
moving between, 78
robotically unloading plates, 81
with inventory manager, 62

D
database

backup, 65
connection, 66
inventory management, 62
reinventorying, 95
reinventorying, connection checking, 97
setting up, 66
SQL, 62
synchronizing, 64

disposable tip capacity property, 32
disposable tip length property, 32

G
general properties for labware, defining, 26
guest privilege, 102

I
image, inserting labware, 38
Incubate at Storage Device task, 64
inventory editor, 63

close, 67
opening, 67

inventory group, defined, 68
inventory management, database, 62
inventory manager, 63

database connection, checking, 97
filters, 90
overview, 62
views, 90

inventory, synchronizing, 64
inventory. see reinventory

J
job roles for readers of this guide, vi

K
knowledge base, viii

L
labware

adding, 24
classes page, 33
defining classes, 33
defining general properties, 26
defining pipette/well properties, 31
defining plate properties, 27
defining stacker properties, 46
inserting an image, 38

labware editor
classes page, 18
entries page, 17
opening, 22

length of filter tip/pin tool property, 30
lid

departure height property, 29
gripper offset property, 29
resting height property, 29

lidded stacking thickness property, 29
lidded thickness property, 29
liquid library

adding an entry, 55
calibrating VPrep, 53
classes defined, 52
database defined, 52
editor defined, 52
opening the editor, 54

liquid library editor
about, 53
opening, 54

Load task, 64, 67
defined, 64
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Index

location group, 63
creating, 70
defined, 68
deleting, 71

lower plate at VCode property, 29

M
maximum robot handling speed property, 30

N
notch locations property, 48

O
online help, viii
opening

labware editor, 22
liquid library editor, 54

operator privilege, 102
orientation sensor offset property, 47
orientation sensor threshold (max) property, 47
orientation sensor threshold (min) property, 48

P
passwords

about, 103
changing, 103

PDF guide, viii
pipette/well, defining labware properties, 31
plate group, 63

changing processing order, 73
creating, 72
creating with barcode input file, 88
defined, 68
deleting, 73
processing plates using, 84, 85

plate group editor, 62
Plate Hub Carousel, 74
plate inventory. see reinventory
plate properties, defining, 27
PlateHub Carousel

with inventory manager, 62
manually loading plates, 76
moving plates between, 78
robotically loading plates, 75
robotically unloading plates, 81

plates
moving between storage devices, 78

post-aspirate
delay property, 56

post-dispense delay property, 56
presentation offset property, 47
privileges

defined, 102
effect of, 102

types, 102
property, 28

acceleration, 55, 56
can be mounted, 30
can be sealed?, 29
can have lid?, 29
can mount, 30
check orientation, 48
column-wise teachpoint to well, 32
column-wise well to well, 32
disposable tip capacity, 32
disposable tip length, 32
length of filter tip/pin tool, 30
lid departure height, 29
lid gripper offset, 29
lid resting height, 29
lidded stacking thickness, 29
lidded thickness, 29
lower plate at VCode, 29
maximum robot handling speed, 30
notch locations, 48
orientation sensor offset, 47
orientation sensor threshold, 47, 48
post-aspirate delay, 56
post-dispense delay, 56
presentation offset, 47
row-wise teachpoint to well, 32
row-wise well to well, 32
sealed stacking thickness, 29
sealed thickness, 29
sensor intensity, 48
shim/nesting thickness, 28
stacker gripper offset, 47
stacking thickness, 28
thickness, 28
use vacuum clamps, 48
velocity, 55, 56
well depth, 31
well diameter, 31
well geometry, 31
well volume, 31
well-bottom shape, 31
z-axis acceleration into wells, 56
z-axis acceleration out of wells, 56, 57
z-axis speed into wells, 56
z-axis velocity into wells, 56
z-axis velocity out of wells, 56, 57

R
reinventorying storage device, 95
row-wise teachpoint to well property, 32
row-wise well to well property, 32
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S
sealed stacking thickness property, 29
sealed thickness property, 29
sensor intensity property, 48
shim/nesting thickness, 28
slot, defined, 62
SQL database, 62
stacker gripper

offset property, 47
stacker, defining properties for labware, 46
stacking thickness property, 28
storage device

manually loading plates, 76
manually unloading plates, 82
reinventorying, 95
robotically loading plates, 75
robotically unloading plates, 81

StoreX, 74
manually loading plates, 76
manually unloading plates, 82
moving plates between, 78
robotically loading plates, 75
robotically unloading plates, 81
with inventory manager, 62

synchronizing inventory database, 64
system, defined for inventory management, 64

T
technician privilege, 102
thickness property, 28

U
Unload task, 64, 67

defined, 64
use vacuum clamp property, 48
user accounts

adding, 103
changing password, 104
disabling, 103, 104
editing, 103
passwords

resetting, 103
privileges, 102
resetting lock out, 104

V
velocity property, 55, 56

W
well depth property, 31
well diameter property, 31
well geometry property, 31
well volume property, 31

well-bottom shape property, 31

Z
z-axis

acceleration into wells property, 56
acceleration out of wells property, 56, 57
speed into wells property, 56
velocity into wells property, 56
velocity out of wells property, 56, 57
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